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Cyrillic 3 Standard Version © Cherwell Scientific Limited  1999 

All rights in this product are reserved to Cherwell Scientific Limited (the 
'Publisher'). 

This end user license agreement describes the rights and warranties granted to its 
customers by the Publisher.  By using the enclosed CD-ROM you, the customer, are 
agreeing to be bound by the terms of this agreement, which includes the software 
license, software limited warranty, and hardware limited warranty.  If you do not 
accept these terms you may within 30 days of purchase return the CD-ROM 
containing the Software, unused and intact to the Publisher together with proof of 
purchase for a full refund. 

1. License:  The Publisher grants the customer and the customer accepts a 
non-exclusive, and non-transferable license to use Cyrillic 3 Standard Version 
software (the 'Software') for so long as the customer complies with the terms of 
this Agreement. 

2. Copies:  The Publisher grants the customer the right to make copies of the 
Software for back-up purposes only. The customer agrees to reproduce and 
incorporate this license agreement on any copies.  It is expressly understood 
that such copies will not be used for any purpose except to substitute for the 
initial copy in the event that it is unusable. 

3. Use:  In addition, the license granted herein includes the right to move the 
Software from one computer to another provided that the Software is used on 
only one computer at a time and that two people will not use the program at 
the same time on different computers. 

4. Security:  The customer agrees to secure and protect each CD-ROM, the 
documentation, and copies thereof from copying (except as permitted above) or 
from modification and shall ensure that its employees or consultants do not 
copy or modify the Software or the documentation. 

5. Ownership:  The Publisher represents that it has the right to grant the licenses 
herein granted. 

6. Limited Warranty: The Publisher warrants the Software will perform 
substantially in accordance with its accompanying documentation and that the 
documentation correctly describes the operation of the Software in all material 
respects for a period of 90 days from the date of purchase of the CD-ROM.  If 
the Publisher is notified of significant errors during this time it will correct any 
such demonstrable errors in the Software or the documentation within a 
reasonable time or (at its option) provide or authorize a refund of the price paid 
by the customer against return of the CD-ROM (containing the Software) and 
the documentation and written confirmation from the customer that all copies 
of the Software (whether made from the CD-ROM or by download from the 
Publisher’s web site) have been destroyed including any Software stored on the 
hard disk of any computer under the customer’s control.  The above represents 
the customer’s sole remedies for any breach of the Publisher’s warranties. 

 

Whilst all reasonable efforts have been made to test the Software and the 
documentation prior to first publication the customer acknowledges and accepts 
that the Publisher has not produced the Software or the documentation to meet 
the customer’s own specifications and that the Software could not be tested in 
every possible combination and operating environment and that it is not 
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possible to produce economically (if at all) computer programs known to be 
error free or which operate in an uninterrupted manner and that not all errors 
are necessarily capable of rectification. 

 

7. Liability:  (a)  The Publisher will not in any circumstances be liable to you or to 
any other person for any loss of profits or contracts or any other consequential 
or indirect loss or damage arising directly or indirectly (as a result of the 
negligence of Cherwell or otherwise howsoever) in connection with the supply 
of the CD-ROM (containing the Software)  and the documentation or their use 
by you. 

 (b)  Except for any liability of the Publisher for injury to or the death of any 
person caused by negligence, which shall be without limit, the aggregate 
liability of the Publisher howsoever arising from or in connection with the 
supply of the CD-ROM (containing the Software) and the documentation 
(whether for breach of Agreement, negligence, misrepresentation or otherwise 
howsoever) will be limited to 125% of the aggregate invoice price of the CD-
ROM (containing the Software) and the documentation in question. 

8.   Law:  This Agreement shall be governed by English law. 

 

Should you have any questions concerning this license or this limited warranty or if 
you want to contact Cherwell Scientific for any reason, please write to: 

Cherwell Scientific Limited, The Magdalen Centre, Oxford Science Park, Oxford 
OX4 4GA, United Kingdom 

 

Cyrillic 3 Standard Version is distributed with BrCaPro, a genetic risk analysis 
program, and MENDEL, a set of FORTRAN 77 routines.  Both of these programs 
are the work of third parties and were not authored by and are not owned by 
Cherwell Scientific Limited (“Cherwell”).  Cherwell distributes them “as is” and 
the customer uses them entirely at its own risk.  If this is not acceptable to the 
customer, then the customer should not use the programs. 
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Copyright 1997, 1998, 1999. Duke University.  All rights reserved.  

BrCaPro is provided by Duke University without charge as a service to the research 
community.  BrCaPro is provided "as is", without any warranties, express or 
implied, including any warranty of merchantability (or satisfactory quality) or 
fitness for a particular purpose, or that its use will not infringe upon any patent, 
copyright, trademark, or other rights.  Cherwell, Duke University, and the 
developers expressly disclaim any and all liability arising out of the customer’s (or 
any other person’s) use of BrCaPro.  No modification, copying, selling, sublicensing 
or other distribution of BrCaPro may be made other than as allowed under the 
license for Cyrillic 3 Standard Version.  BrCaPro is developed by G Parmigiani, DA 
Berry and O Aguilar, authors of "Determining Carrier Probabilities for Breast 
Cancer Susceptibility Genes BRCA1 and BRCA2", Am. J. Hum. Genet., 62:145-
158,1998.  Information for those who would like to obtain copies of BrCaPro 
separately from Cyrillic 3 Standard Version can be found at 
http://www.stat.duke.edu/~gp/brcapro.html. 

Cyrillic 3 Standard Version uses the Fortran 77 version of MENDEL developed by 
Ken Lange.  The developer provides MENDEL free of charge and assumes no legal 
liability for use of his software or algorithms.  MENDEL is provided "as is", without 
any warranties, express or implied, including any warranty of merchantability (or 
satisfactory quality) or fitness for a particular purpose, or that its use will not 
infringe upon any patent, copyright, trademark, or other rights.  Cherwell and the 
developer expressly disclaim any and all liability arising out of the customer’s (or 
any other person’s) use of MENDEL 

BrCaPro 

MENDEL 
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© Cherwell Scientific Limited 1997-1999 
All rights reserved. No part of this publication or the program Cyrillic 
may be reproduced, transmitted, transcribed, stored in a retrieval system, 
or translated into any language or computer language in any form or by 
any means, electronic, mechanical, magnetic, optical, chemical, manual, 
biological, or otherwise, without prior written permission of the 
publisher. 

This manual refers to the Standard Version of Cyrillic 3.  

All trademarks and registered trademarks are the property of their 
respective companies.  

Cyrillic was originally written by Cyril Chapman. 
Professor John Edwards is acknowledged for his contribution to the 
development of the haplotyping algorithm. Richard Houlston is 
acknowledged for his assistance with risk calculations. 

Cyrillic is published by: 
Cherwell Scientific Limited 
The Magdalen Centre 
Oxford Science Park, Oxford  OX4 4GA 

To get help with Frequently Asked Questions (FAQs) or product 
information, please visit our web site at 
http://www.cyrillicsoftware.com 

Technical Support is available by phone, fax and e-mail direct to the 
Cherwell Scientific Oxford office. Front-line support is also available 
through our US office.  

Technical support contact information: 

United Kingdom Tel.: +44 (0)1865 784800 
Fax.: +44 (0)1865 784801 
e-mail: support@cyrillicsoftware.com 

 USA 
 

Tel: 978-263-6066 or 1-888-257-6652  
Fax: 978-635-5330 
e-mail: 
support.usa@cyrillicsoftware.com 

Germany 
 

Tel: (069) 970841-11 
Fax: (069) 970841-41 
e-mail: 
support.d@cyrillicsoftware.com 
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If you need to contact Cherwell Scientific for support, it would help if 
you have the following information to hand:  

• Your serial number and the version of the software you are using 

• The versions of the system software you are using and the amount 
of memory used 

• A detailed description of what you were doing when the problem 
occurred 

• Any special information, e.g. the type of printer, if it is a printing 
problem  

• If possible, have your program up and running in front of you 
with a copy of the user manual as you speak to us 

For some years Senior Lecturer in Clinical Genetics at the University 
of Auckland School of Medicine, Dr Chapman moved to the Churchill 
Hospital, Oxford, in the summer of 1993, where he is now Clinical 
Director in the Department of Clinical Genetics. Cyrillic has its origins 
in a program developed by Dr Chapman from 1987 to 1989 for the 
Atari ST. The intention was to create a simple interactive method of 
entering pedigree data and family trees on the screen. The program 
has retained this original focus while it has evolved through several 
versions and operating environments. An early version of Cyrillic was 
described in a paper in the American Journal of Medical Genetics, 1990 
36:155-160. The  program's name was coined by the clinical geneticist 
Dr Mac Gardner who combined the name of the programmer with an 
interest he had in the Russian language. 

In this new version Cyrillic has been rewritten under Dr Chapman's 
guidance by a team of expert programmers.

Note on the 
Developer 
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1. Introduction 

Principal features 

Cyrillic 3 is a program designed to display the most useful 
information about a pedigree for people working in human genetics, 
clinical genetics and genetic counseling. In addition all information 
relating to the pedigree is stored in a fully functioning database.  
Some of the principle features of this new version are: 

• Easy drawing tools 

• Integrated database which is updated as you draw 

• Enhanced printing options 

• Integrated risk calculations using BRCAPRO and MENDEL 

• Database support includes Microsoft Access and Borland Paradox 

Individuals and families may be added to the drawing using toolbars 
and menus. Manipulation of the pedigree is simple using the mouse 
(click and drag) and individual properties (identification, age, genetic 
status) can all be added via dialogs or using the spreadsheet like table 
view. We have included two public domain genetic risk analysis 
programs, MENDEL and BRCAPRO. Cyrillic provides a convenient 
data input interface for these programs making risk analysis simple. 
You may use published data or data from your own research with 
these programs and the output may be saved to file or printed along 
with your pedigree. 

The maximum size of a family is limited mainly by the processing 
power of your computer. 

New in Cyrillic 3 Standard Version 

• In this version the underlying code has been completely rewritten. 
This version maintains Cyrillic’s user-friendly drawing interface 
but you will find it easier to use and more stable than ever before 
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• All information stored in a database 

• New drawing interface 

• Table view constantly updated through link to the database and 
may be kept in view or removed 

• Completely user-defined view options for display in the pedigree 
or  the table view 

• Access and Paradox database formats currently supported 

• New drawing tools to make pedigree drawing quick and easy. 

• Risk analysis using integrated tools (MENDEL and BRCAPRO). 

• Improved printing and print options 

• This version is intended primarily for genetic counselors and 
clinicians and does not include genetic marker function or 
haplotyping. These will be available in the Cyrillic 3 Research 
Version. 

Hardware and Software requirements 

Cyrillic 3 requires Windows 98/95 or NT version 4. The main 
program will take up to 20MB of hard disk space. Installation of the 
BDE which supports the database functionality will take an additional 
15MB. The installation files are shipped on a CD-ROM disk and 
therefore your system will need a CD drive. Otherwise the standard 
Windows 98/95/NT minimum hardware requirements must be met. 

Installing Cyrillic 

Place the Cyrillic CD into you CD-ROM drive and follow the on-
screen instructions. The installation routine should start on its own 
but if for any reason it does not: 

• Click the Start button on the windows task bar and select Run… 

Main Cyrillic 
installation  
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• In the dialog box type D:\Setup.exe (assuming that D is the name 
of your CD drive) and Click OK 

This is an independent installation and will not overwrite any older 
versions of Cyrillic. The installation includes a number of important 
files and applications. Some of these are as follows: 

• Cyrillic.exe. This is the main Cyrillic application. A shortcut will 
be added to your Start|Programs menu. You can also start the 
application by double clicking this file in Windows Explorer. 

• BDE or Borland Database Engine. This controls all the database 
functions of Cyrillic 3 (see below for installation issues). 

• runMENDEL.dll. This contains the Fortran 77 code of the 
MENDEL risk analysis program. 

• BRCAPRO4.exe. This is the program which runs the BRCAPRO 
analysis. 

• Hdk3anim.dll and Hdk3ctnt.dll (in the Windows System folder). 
these are supporting files for the Cyrillic Help system. 

• Example.mdb. This is a sample database and contains some of the 
pedigrees described in this manual. 

If your computer is a shared workstation or uses a shared copy of the 
Borland Database Engine, please ask your network administrator to 
read the following section before you attempt to install Cyrillic 3. 

If you are a current BDE user (ask your Network Administrator) and 
you are trying to install the software on a PC where the Borland 
Database Engine already exists, it is possible that the installation will 
fail. If the BDE files are read-only, or the current user has read-only 
access to the BDE directory (network or local) then installation will 
fail. 

Resolving this involves 

• Logging on with write-access (e.g., as Administrator -- also 
required if ODBC is installed) 

The BDE 
installation 
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or 

• Making the files NOT read-only, 

or (in the case of a network installation)  

• Remove the following two keys from the registry: 

"HKEY_LOCAL_MACHINE\Software\Borland\BLW32" 

"HKEY_LOCAL_MACHINE\Software\Borland\Database Engine" 

This will allow the BDE to install locally. 

IMPORTANT: This last option involves editing the registry. Before 
you edit the registry, make sure you understand how to restore it if a 
problem occurs. For information on how to do this, see the "Restoring 
the Registry" Help topic in Regedit.exe or the "Restoring a Registry 
Key" Help topic in Regedt32.exe. 

If you are in any doubt the consult your systems/network 
administrator or call the Cyrillic support team. 

Licensing Cyrillic 

Cyrillic 3 Standard Version is designed as a desktop or single user 
software application. Cyrillic’s security locks the application to the 
machine on which it is installed. Therefore you will not be able to 
install Cyrillic 3 on a network drive and run it from a remote 
computer. This also means that you must follow certain procedures in 
order to transfer the software to a different computer - the License 
agreement does not allow you to run Cyrillic on two different 
machines at the same time. 

If you have not yet purchased Cyrillic you can use a fully functioning 
version of the software for a 30-day trial period. 

Each time you start Cyrillic the license dialog box appears. Simply 
click the “Demo License” button to use all the features of Cyrillic for 
the remainder of your 30-day trial period. When this period has 

Cyrillic software 
security 

Demo license 
button 
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expired this button will gray out and you must purchase the software 
if you wish to continue to use it. 

When you purchase Cyrillic you need to activate the license before 
you can start to use the software (unless you are taking advantage of 
the 30-day trial period – see previous section). To do this you need to 
register the software with Cherwell Scientific Ltd. When you register 
with us you will be given a code which will activate your full license. 

In order to activate your full license, please carefully follow the 
instructions outlined below. 

When you start Cyrillic the license dialog box appears: 

• Click the Full License button 

• Make a note of the two numbers labeled: User Code 1 and User 
Code 2 

• Click the Freeze button 

This freezes the two User Codes providing us with a unique identifier 
to enable us to create your license activation code. It also closes the 
application. 

• Now contact Cherwell Scientific, by any of the methods outlined 
below, to request your license activation code. Please provide the 
following items of information: 
 

• Contact details – name, address, telephone number, e-
mail address 

• The software serial number (this can be found on the 
software box, on the software CD jacket and on the 
inside cover of the user manual) 

• The two user codes, User Code 1 and User Code 2, 
that you made a note of prior to clicking the Freeze 
button. 

Cherwell Scientific contact information: 

Full License 
button 
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Telephone 1-888-257-6652 

44 1865 784800  

in the Americas 

in Europe and the rest of the 
world 

Fax:  You will find an Activation Code Request Form 
located in the Cyrillic 3 folder under the Programs 
folder on your Windows Start Button 

e-mail: license@cyrillicsoftware.com 

Cyrillic web site www.cyrillicsoftware.com 

 

Once you have received your activation code from us start your 
Cyrillic software and the license dialog box will appear. 

• Click the Full License button 

• Type the activation code into the Activation Code box and 
click OK.. 

Your software is now fully licensed. 

This is used when you wish to install Cyrillic on a new machine - see 
below for the full description of how to transfer your user license to a 
different computer. 

Once you have registered Cyrillic 3 a single user license will not allow 
you to install and run the software on another computer. Under the 
single user license you are allowed, however to transfer your license 
to a new machine. Doing this deactivates the license on the old 
machine. Following the procedure below allows you, for example, to 
install Cyrillic at home as well as in the office but you must transfer 
the license each time. You will not be able to install on two machines 
and run the software on both at the same time. To prepare a license 
transfer you will need a floppy disk. 

The following description assumes you wish to run Cyrillic at home 
as well as in the office - but obviously applies to any transfer such as 
reinstalling Cyrillic if you should upgrade to a new computer. 

Transfer License 
button 

Installing Cyrillic 
-- on another 

machine 
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The license transfer works by generating a request for a license 
transfer whilst at home. When you take this request to the office on a 
floppy disk the offce computer recognizes the request and checks out 
the license to the floppy. When you return home check in the license. 
From then on you can easily transfer the license between the 
machines, checking out from one before checking in to the other. 
Always remember to save your work before starting the transfer 
process. 

• Install Cyrillic on your computer in the office 

• Request an activation code from Cherwell Scientific Ltd 

• Activate Cyrillic 

• Install Cyrillic on your computer at home 

• When prompted choose to Continue unlicensed 

• When you have finished your session save your work 

• Place a floppy disk in the disk drive 

• Select the Help|License Transfer menu item 

• Click the Request license radio button and click OK to start the 
license request 

• Click OK to close the confirm dialog 

• Note that if you are outside the 30 day trial period you will be 
returned to the opening 'unlicensed' dialog 

When you return to the office your version of Cyrillic is still licensed 
and so it will start and function properly. When the time comes to go 
home you will need to check out the license to the license transfer to 
the floppy, now called the Transfer disk. So, when you have finished 
saved your work: 

• Place the Transfer disk in the floppy drive 

• Select Help|License Transfer 
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• Click OK to check out the license 

A dialog will confirm that the Cyrillic license has been transferred. 
When you click OK the application will close. Now take the Transfer 
disk home and start Cyrillic again. Remember that this version is still 
unlicensed and so you will be prompted to either continue unlicensed 
or to Activate the license: 

• Click Continue unlicensed 

• Place the Transfer disk in the floppy disk drive 

• Select Help|License Transfer 

• Click the Check in license radio button 

• Click OK 

A dialog will confirm that the license transfer is complete and you 
will be able to continue working. When you have finished you will 
need to check out the license in order to transfer it back to the office. 

• Save your work 

• Select Help|License Transfer 

• Click OK to check out the license 

A dialog will confirm that the version of Cyrillic is now unlicensed 
and will terminate the application. 

When you start Cyrillic in the office you wil be grreeted by the 
License dialog.  

• Insert the Transfer disk  

• Choose Transfer License  

• select Check in license in the next dialog and click OK 
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Now each time you change machines you will now simply check out 
the license from the machine you are currently working on and check 
in on the other machine. 

The current user license allows you to install Cyrillic on a single 
computer. The software security locks the application to a particular 
machine and you will therefore not be able to install on a network and 
run it from a remote machine. You may, however, be able to share 
databases on a network drive. If you do this then you should consider 
the following: 

• You should have read write permissions for the network drive or 
drives 

• More than one person will be able to access and work on a single 
database 

• The pedigree you open will be locked to other users 

• If you are using risk analysis tools, manifestations and disorders 
then these are a property of the database and the database will be 
locked 

In all cases you should first check with your systems/network 
administrator before calling the Cyrillic support team. 

About this manual 

This introduction provides an overview of the program and basics of 
using Cyrillic 3. If you are familiar with using Microsoft Windows or 
have used previous versions of Cyrillic you can probably skip this 
part. Chapter two is a quick guided tour of Cyrillic 3. The bulk of the 
manual is a task-oriented guide to using the functions in Cyrillic 3. 
This ranges from the basics of file manipulation, pedigree drawing 
and printing to the more in depth risk analysis functions. Finally a 
reference section details important information you may find useful in 
using Cyrillic 3. 

Using Cyrillic on 
a network 
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Conventions and notation used in this manual 

Cyrillic has been developed to allow you to work in a manner you 
find most convenient - either with the mouse, keyboard or a 
combination of the two. There are usually two or three ways to do 
most things. Below is a list of conventions and terms used in the rest 
of the help file. 

In this help file we use the following terms to describe mouse 
functions. 

• Point: move the mouse until the cursor is over an object. 

• Click: Press the main mouse button (usually the left button) once. 

• Select: Clicking on an object highlights the object showing that it 
has been selected. e.g., selecting an individual creates a red square 
around the individual, clicking on a marriage line highlights the 
line. Once an object is selected certain Cyrillic functions become 
active. In menus and toolbars you will notice that more items 
become active (inactive items are grayed out). Several objects may 
be selected by clicking on them in sequence whilst holding the 
control (Ctrl) or Shift key down. If you have the Table (grid) View 
open the individual row is also highlighted making it easy for you 
to find the properties and data relating to that individual. 

• Double-click: Press the mouse button twice in quick succession. 
Double clicking usually performs some function such as opening 
a dialog box pertaining to the object on which you have double 
clicked, e.g. double clicking an individual opens the Individual 
Properties dialog box, double clicking a marriage line opens the 
Marriage Properties dialog box. 

• Drag: Objects can be moved around the Windows desktop by 
dragging them. This means clicking on the object and holding the 
mouse button down whilst moving the mouse. Multiple 
individuals may be selected by clicking on an empty part of the 
drawing and dragging the mouse around the group you wish to 
select. 

• RMB, The Right Mouse Button: This is conventionally the 
secondary mouse button. If you are left handed you may have 

Mouse functions 



Chapter 1   

Introduction 11 

reset the mouse buttons (using the Mouse Properties dialog from 
the Windows Control panel) but in this manual we always refer to 
the secondary button as the right mouse button or RMB. Clicking 
with the RMB on an object invokes a context menu. This is a menu 
of functions relating directly to the object which has been clicked. 
You may see additional functions but unless the are available for 
that object then they will be grayed out and cannot be selected. 

The keyboard may be used for just about every function within 
Cyrillic 3. This includes data or text input, opening menus and dialog 
boxes. Keyboard alternatives to mouse functions are often called 
keyboard shortcuts. The notation used for these refers to the common 
name or label of the key, Shift, Ctrl, Alt and F1, Q,W,E and so on. 

Shortcuts often involve pressing more than one key at a time. 
Instructions such as Alt+F3 mean press the Alt key and whilst holding 
it down press the F3. It is not necessary to press them both at exacttly 
the same moment. 

The main menu bar is at the top of the Cyrillic window. All functions 
can be invoked using these menus. To open view a menu: 

• Click on the menu with the mouse 

or 

• Press the Alt key and the letter which is underlined in the menu 
text. e.g. for the File menu click Alt+F 

Not all menu items are available all of the time. Those which are 
unavailable will be grayed out and cannot be selected. Many menus 
have sub-menus e.g. the Modify Individuals menu: 

Keyboard 
functions 

Menus 



Chapter 1 

12 Introduction 

 

In the manual and help file the instruction to select the item Change to 
male will appear as: 

• Select Modify Individuals|Gender|Change to male menu item 

There are two ways to do this. With the mouse and with the 
keyboard. 

1. With the mouse: 

• Click on the menu text, Modify Individuals, in the menu bar 

• Point to the Gender item 

• Point to the Change to male item in the sub menu 

• Click to select this item 

Note that items are highlighted as your cursor moves over them. 
Items with sub-menus are easy to see because they have an arrow 
pointing to the right. 

2. With the keyboard: 

• Press Alt+M to open the main menu 

• Use the down arrow key to move through the items 

The Modify 
Individuals menu 
with Gender sub- 

menu selected 
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• When you reach the gender item press the Right arrow to open 
the sub-menu 

• Use the down arrow again to highlight the item of choice 

In this case it is the first item and is automatically highlighted. 

• Click Enter to select 

The change is invoked and the menu closed. 

Dialogs or Dialog boxes are secondary windows which allow the user 
to add or change data and program settings. There is no special 
notation used for dialogs though the following section shows how the 
different elements may be used to make selections or additions to 
your pedigree. 

Using dialog boxes 

A dialog typically comprises some or all of the elements described 
below. A typical example is the Individual properties dialog (Chapter 
6). 

To select a property prior to editing: 

• Click on the item with your mouse 

or 

• Use the Tab key on your keyboard to cycle through all the 
available components 

When a dialog component is selected this will be indicated:  

• Edit boxes show a flashing cursor 

• Drop down lists and edit boxes with default values highlight the  
text 

• Check boxes display a dotted line around the label text 

Dialogs 

Navigating 
dialogs 
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Usually placed at the bottom right or top right of the box. Labels 
include an underlined letter e.g., OK. pressing Alt+ the underlined 
letter has the same effect as clicking on the button with your mouse. 
The three most common buttons are: 

• OK: Accepts any changes and closes the dialog.  

Pressing the Return key may also result in the dialog accepting 
changes and closing. Exceptions are when you are editing text or 
number boxes where you are permitted to add carriage returns e.g., 
when adding text to the Annotation dialog (see Chapter  9. 
Annotating the pedigree.). 

• Cancel: Closes the dialog without making any changes 

• Help: Opens the help file at a page detailing the dialog box 
and/or its related functions 

If there are a number of items from which one is to be selected a drop 
down list is used. The default item is displayed in the box and clicking 
the down arrow at the right hand side opens the list.  

 

The scroll bar is used to show items which are initially out of view. As 
with menus items are highlighted when the mouse cursor is placed 
over them. To select an item from a drop down list: 

• Click the down arrow at the right hand side 

• Locate the item you wish to select either by dragging the scroll bar 
up and down or clicking on the up and down arrows 

• Click the item 

Buttons 

Drop down lists 

The proband drop 
down list from the 

Individual properties 
dialog 
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You can also select items using the keyboard. The list is selected when 
the default item is highlighted.  

• Press the Down or Right arrow key to move through the list 

In this case the list does not actually open but items are displayed in 
turn in the box. 

If you reach the end of the list you can move back up by pressing the 
Up or left arrow key until you locate the item you wish to select. 

An edit box is a box where the user can enter text of their own. There 
may be restrictions on the length of text but warning will be given if 
you make a mistake in this respect. Some edit boxes only accept 
numerical text. In this cases a default number is included when the 
dialog is opened and they usually have up and down arrows on the 
right hand side. Clicking on an arrow with the mouse increases (up) 
or decreases (down) the value. Some text edit boxes are multi line and 
can accept carriage returns without closing the dialog. 

A check box is used when there are only two possible settings for the 
property - on or off. These appear as a small square  - much smaller 
than an edit box or drop down list. To change the setting: 

• Click on the box or the text 

or 

• Press the Space bar 

The item is set to On when a tick is shown in the check box. If you are 
using the keyboard to navigate through the dialog the item is 
available to be changed when a dotted line appears around the label 
text. 

Radio buttons are similar to check boxes and are used to choose 
between a number of exclusive options. 

 

Edit boxes 

Check boxes 

Radio buttons 

The 'affection pattern' 
radio buttons in the 

Define Manifestations 
dialog 
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Radio buttons generally appear as circles and when selected have a 
black dot placed in the circle. In this example you can choose 1 or 2 
affections, but not both. To select one affection: 

• Click on the button - the circle adjacent to the text or on the text '1 
affection' 

or 

• Press Alt + 1 (note that the '1' is underlined) 

To select a property prior to editing: 

• Click on the item with your mouse 

or 

• Use the Tab key on your keyboard to cycle through all the 
available components including the buttons 

When a dialog component is selected this will be indicated:  

• Edit boxes show a flashing cursor 

• Drop down lists and edit boxes with default values highlight the 
text 

Check boxes display a dotted line around the label text. 

Navigating 
dialogs 
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2. A Cyrillic guided tour 

This guided tour is intended to give an overview of the principle 
features of Cyrillic 3 Standard Version. The following chapters show 
how to perform individual tasks but for a start it will be useful to 
become familiar with the Cyrillic interface. 

The installation routine for Cyrillic automatically adds a Program 
item to the Start|Programs menu on your Windows desktop. To start 
Cyrillic: 

• Select the Start|Programs|Cyrillic 3| Cyrillic item from the 
Windows task bar 

If this is the first time you have started Cyrillic the Recent pedigrees 
dialog will be empty and so click Cancel to close it. Initially the 
program interface is fairly empty so you need to open a database. We 
have included a sample database, tutorialr.MDB with the installation. 
This includes the pedigrees used in this tour and those used in some 
of the later tutorials. To open a database: 

• Click the Connect database icon or select the File|Connect 
database menu item 

• In the dialog that appears click Connect MS Access and from the 
open database dialog select tutorial.MDB and click Open 

• The Database properties dialog opens automatically and so click 
OK to close it 

Note that you do not need to have Microsoft Access on your system. 
Cyrillic merely stores the data in this format. If you do, however, have 
Microsoft Access you will be able to open and look at the database 
using the database application. 

You now need to open a pedigree. 

• Click the Open Pedigree icon or select the File|Open pedigree 
menu item 

• In the Open pedigree dialog select Guided Tour and click Open 

Step 1: Start 
Cyrillic 
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The Cyrillic interface should now look something like the figure 
below. 

 

The window is divided into five main regions. In the center is the 
drawing area, conveniently marked out by dotted lines into pages. At 
the very top is the menu bar. To open a menu just click the menu 
name with the mouse or press the Alt button on your keyboard and at 
the same time press the letter that is underlined in the name. Below 
the menu bar are the toolbars. The icons on the toolbars allow you to 
control almost every aspect of Cyrillic using your mouse. Underneath 
the drawing area is the Table view. This is constantly updated with 
information added to the pedigree. Alternatively you can add 
information directly to this spreadsheet like view of the pedigree. For 
example  

• Click on the individual named Peter and note that the column 
with First name 'Peter' in the table is also highlighted 

Take a look 
around 

The Cyrillic window 
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• Click on the cell containing the First name and press Enter 

• Type the new name Robert and press Enter 

At the very bottom of the Cyrillic window is the status bar. This lists 
relevant information about the pedigree; the path and name of the 
database, the name of the current pedigree and basic information e.g. 
the number of individuals and number of marriages. 

Drawing with this version of Cyrillic is very easy indeed. You can use 
menus or toolbars to add new individuals and relationships. Now we 
will add a family to the middle son (second generation) of the Guided 
tour pedigree. 

• Click the middle son (named Andrew) 

• Click the New partner (female) icon 

• Click New son 

• Click New daughter 

When a new spouse is added the marriage line is highlighted ready 
for the addition of a family of children. Note also that as the family is 
added the pedigree automatically expands to make space. 
Occasionally you may find that siblings overlap or new families are 
closer than you would like. If this happens just click the Redraw 
button. 

If you prefer you can use menus to build your pedigree. All 
individuals are added through the Add individuals menu. This also 
appears in the right mouse button or context menu. 

We have already seen that you can easily edit properties using the 
Table view. Another method is to use the Individual properties dialog 
opened by simply double clicking a symbol. 

The dialog details all of the default properties you may edit. For 
example to edit the properties for Andrew's new spouse. 

• Double click the symbol for the new spouse you have just added 

Step 3: Add some 
new individuals 

Step 4: Edit 
properties 
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• Ensure that the Individual properties tab is selected 

• In the First name edit box of the dialog type the name Anne 

• In the Age edit box type the number 40 

• From the Genetic status drop down list select Carrier 

• Click OK to accept the changes and close the edit box 

You can also change the properties of a marriage. To open the 
marriage dialog double click the relationship line between two 
individuals. To edit the marriage properties of Andrew and Anne: 

• Double click the line joining the Symbols Andrew and Anne 

When a line joining two individuals is selected you will notice that not 
only is this line highlighted but also the lines to all children of that 
relationship. This is particularly useful if you have complex 
relationships where sibships overlap. 

The dialog details the properties of both individuals and you can add 
a relationship ID and any comments. You can also add the type of 
relationship: 

• From the marriage type drop down list select Divorced 

• Click OK and see that the divorced symbol is added to the 
marriage line 

To select an individual just click on the individual symbol. You can 
also move around the pedigree using the Up/Down/Right and Left 
arrow keys on your keyboard. Note that the selected individual is also 
highlighted in the Table view. 

To move an individual: 

• Select the individual 

• Drag the highlighted symbol, with your mouse to the new 
location 

Step 5: Select 
and move 

individuals 
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To select and move a group of individuals: 

• Dragging your mouse cursor around the group of individuals 

or 

• Click on the first individual 

• While pressing the Shift key, click on the additional individuals 

• Click and drag the group to the new location 

Although you can undo single moves in Cyrillic a more useful feature 
is to take a snapshot. This saves the pedigree and all the related 
information at any one time. So as a safety net when making changes 
to pedigrees: 

• Select New snapshot from the Edit menu 

• In the Create new snapshot dialog type a name for snapshot and 
click OK (the default name is Snapshot 1) 

• Change the pedigree - move individuals, add data etc 

• Having decided the changes were unsuitable select Go to 
snapshot from the edit menu and select Snapshot 1 from the sub 
menu 

• In the Create new autosnapshot dialog click No 

Your pedigree reverts to its previous state. This is valuable because 
you can create as many snapshots as you like and it saves all relevant 
data whilst the pedigree is open. 

The Cyrillic window is completely configurable by the user. Perhaps 
you prefer more drawing space than is initially given. To increase the 
space: 

• Remove the table view by placing the cursor over the line 
adjoining the Table view and the main drawing window (the split 
cursor appears when it is positioned correctly) 

Step 6: Take a 
snapshot 

Step 7: Change 
the view 
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• Drag the Table view down until it disappears from sight. To view 
it again simply drag it up again 

• Remove one or all of the toolbars by selecting toolbars from the 
View menu 

• Uncheck and toolbars you wish to remove 

 

You can also rearrange toolbars on the screen by clicking on the bar at 
the left hand side and dragging them (within the toolbar space) to the 
desired location. 

Almost everything else can be changed using the View option dialog. 

• Select Options from the View menu or press F6 

To change the color used to emphasize selections: 

• Click the button labeled Selection 

• Choose a new color from the Color dialog and click OK 

• Click OK to close the View options dialog 

• Select an individual to verify the change 

Now explore the view options dialog. You can change all colors used, 
the size of symbols, how they are spaced on the drawing, whether 
Cyrillic will detect and display consanguinity and the color and shape 
of the proband arrow. To see the changes that can be made to the 
Table view click the Table options tab in this dialog. 

The Toolbars sub 
menu 
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One of the most common tasks is to change the information displayed 
on the pedigree. In Cyrillic this is completely under your control, you 
can even display different information in the Table and on the 
drawing. 

• Open the View options dialog (View|Options menu or press F6) 

• Click Drawing fields 

This opens the Displayed fields dialog. 

 

The left hand panel lists all the data fields that may be displayed. 
These include default data fields, fields you have defined yourself and 
any imported from other pedigree drawing programs. 

The right hand panel lists those currently being displayed. To add a 
field from the left: 

• Select the field in the list by clicking on it 

• Click the button labeled > 

To add all the fields: 

• Click the button labeled >> 

Step 8: Change 
information 

displayed 

The displayed fields 
dialog 
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To remove all the fields: 

• Click << 

• Click OK to accept the changes and then click OK in the main 
Options dialog. 

To set the fields to display in the Table simply click the Table fields 
button in the View options dialog. This opens an identical Displayed 
fields dialog - but changes operate only on the Table view. 

To add a text annotation to your pedigree: 

• Click the Annotation toolbar icon or press Ctrl+T 

• Type some text in the Annotation dialog 

• Click OK to place the text on the pedigree 

The annotation dialog allows you to save the annotation as a simple 
text file (Save as text… button) and to load simple text files from disk. 
A Font buton opens the dialog allowing you complete control over the 
look of the text. Once the annotation is placed on the pedigree you can 
place it anywhere by clicking and dragging. To edit an annotation 
double click the text  to reopen the annotation dialog. 

Printing is controlled though the Print preview window. 

• Ensure that no indivuals are selected (click on an empty part of 
the drawing area) 

• Click the Print preview icon, select Print from the File menu or 
press Ctrl+P 

• In the Print preview window click the Fit to page icon 

• Click the Print icon 

The print preview window provides a complete preview of the 
pedigree before printing. To control the output options open the Page 
setup dialog.  

 Step 9: Add an 
annotation 

Step 10: Print the 
pedigree 
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The toolbar makes it easy for you to fit the pedigree to a single page, 
scan through a large pedigree covering several pages or create a 
circular pedigree to fit it on one page. Explore the toolbar buttons and 
print your pedigree before closing the window and returning to the 
Cyrillic main window. 

In addition to creating pedigrees and saving all relevant data in the 
Cyrillic database you can also: 

• Add to and customize the database by creating your own data 
fields 

• Search the database 

• Highlight or hide sections of the pedigree 

• Import pedigrees from older versions of Cyrillic (2.x) and in CSV 
and GEDCOM format 

• Export CSV and GEDCOM formatted pedigrees 

• Run genetic risk calculations through Cyrillic using MENDEL and 
BRCAPRO 

Other functions 
in Cyrillic 
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3 Starting and exiting Cyrillic 

As with other Windows programs there are several ways to start and 
close Cyrillic. 

Starting Cyrillic 

Installing Cyrillic automatically creates a Cyrillic program item. 

• Select Cyrillic from the Windows task bar start menu, i.e., 
Start|Programs|Cyrillic 3|Cyrillic 

Open Windows Explorer using one of the following methods: 

• Double-click the My computer Icon on the desktop 

• Select Start|Programs|Windows Explorer from the task bar Start 
menu 

• Press the Windows key + E 

• Locate the Cyrillic3.exe file 

The default installation is C:\Program Files\Cherwell 
Scientific\Cyrillic3\Cyrillic3.exe. 

To start Cyrillic: 

• Double click the file Cyrillic3.exe 

You can create a short cut on your windows desktop using the 
following methods. 

• Right mouse click on the Cyrillic 3.exe file in Windows Explorer 

• Select Create shortcut from the context menu 

• Drag the shortcut to the desktop 

or 

From the Start 
menu 

From Windows  
Explorer 

From a shortcut 
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• Simply drag the icon for the Cyrillic3.exe file onto the desktop 

Change the text labeling on the shortcut icon by: 

• Click once on the icon to select but not start the program 

• Click on the text label 

• Edit the text to something you recognize as starting Cyrillic 3 

• To start Cyrillic from this shortcut double click the icon on the 
desktop 

You can add a shortcut to the main start menu rather than using the 
program group on the start menu. 

• Locate the Cyrillic3.exe file in Windows explorer 

• Drag the Cyrillic.exe icon onto the Start button on the Windows 
task bar 

• To start the program select Start|Cyrillic 3 

• Select Start|Run from the task bar start menu 

• When the Run dialog opens type Cyrillic3 in the edit box 

• Click OK or press the Return key 

On starting Cyrillic you will be greeted by the Recent pedigrees 
dialog. This lists all of the pedigrees you have been working on. To 
open the pedigree select it and click Open. This automatically opens a 
database and the pedigree – and is a very quick way of working. You 
can view the Recent pedigrees dialog any time by selecting Reopen 
pedigree from the File menu. 

Closing Cyrillic 

When you have finished working with Cyrillic 3 you can close the 
program in the following ways: 

Using the 
Windows Start 

menu 

Using the Run 
utility 

The recent 
pedigrees dialog 
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• Select File|Exit 

or 

• Click the Close button (labeled x) in the upper right hand corner 
of the Cyrillic window. 

or 

• Press Alt+F4 

In all cases you will be prompted to save any changes to pedigrees 
you have been working on. 
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4. Working with databases 

A key feature of Cyrillic 3 is that all Cyrillic data, including details of 
the pedigree drawing are stored in a database. More information on 
databases in general is given in Chapter 14. Introduction to databases . 
In this chapter we cover some practical aspects of using the Cyrillic 
database; creating, saving, opening and closing databases. 

Create a Cyrillic database 

Although this may sound complex it is no more difficult in practice 
than creating any other file or document. The difference is behind the 
scenes. You select menu items and use dialog boxes but Cyrillic 
creates the infrastructure of the database which is more complex than 
a simple document or file. 

Start Cyrillic as shown in the Chapter 3. Then either: 

• Select the File|Connect database menu item 

or 

• Click the Connect database icon on the Database Toolbar 

This opens the Connect to database dialog. 

 

This comprises four main buttons. To create a new database in 
Microsoft Access format: 

• Click Create MS Access 

This opens the New database dialog. As indicated in the Connect… 
dialog you can also create a database in Paradox format. 

Create a 
Microsoft Access 

database 

The Connect to 
database dialog 
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This 'new file' type of dialog opens in the default location (the main 
Cyrillic 3 folder). If you wish to store your database elsewhere then 
use the Save in: drop down list and the Up one level button to 
navigate to the required location on your hard drive or network. Once 
you have located the folder where you will store the database: 

• Type a suitable name for the database in the File name edit box, 
e.g., tutorial 

• Click Save 

It may take a few seconds for the database to be created. After a short 
time the Database properties dialog opens. This details the name and 
location of the database and allows you to add useful notes for future 
reference. 

The New database 
dialog 
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When creating a database the Database properties dialog opens. This 
details the name and location of the database and allows you to add 
useful notes. 

• Type your name or initials in the Author edit box 

• Add any notes to the Comments edit box 

• Click OK 

The Properties dialog displays the date the database was created and 
when it was last edited - these cannot be changed by the user. If you 
wish to view or edit the database properties at any time: 

• Choose the File|Database properties menu item 

The procedure is similar to creating an Access database but a slightly 
different dialog is used. Paradox databases consist of a number of files 
held in a single folder. When creating a database you therefore need 
to create a folder. 

• In the Connect database dialog click Create Paradox 

The database 
properties dialog 

Setting the 
database 

properties 

Create a 
database in 

Paradox format 
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If you have already created a folder for your Paradox database, using 
Windows Explorer for example, use the navigation tools for locating 
the folder. If you wish to create a new folder: 

• Type the name of the folder in the Directory name edit box 

• Click OK 

You will then be prompted to confirm that Cyrillic should create the 
folder. Accepting this leads you to the database properties dialog as 
for the Access database. 

Other common database functions 

Once created the database is automatically saved - note that there is 
no option to 'Save database' on the File menu. The only thing you 
have to save is the pedigree. 

You may wish to work on pedigrees in different databases but you are 
only allowed to have one database open at a time. To close a database: 

• Select File|Disonnect  database 

or 

The Select directory 
dialog used for 

creating Paradox 
databases 

Saving the 
database 

Close the 
database 
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• Click the Disconnect database icon on the Application Toolbar 

You will be prompted to save your work (changes to pedigrees) 
before the database closes. 

To open an existing database either: 

• Select the File|Connect database menu option 

or 

• Click the Connect database icon on the Database Toolbar 

This opens the Connect to database dialog box 

• Click Connect MS Access or Connect Paradox 

 Now: 

• Navigate to the database location using the Look in drop down 
list or the Up one level button 

• Click on the database with which you wish to work 

• Click Open 

This opens the Database Properties dialog. 

• Make any additional notes 

• Click OK to close the dialog 

When opening a Paradox database the dialog requires that you locate 
the folder in the directory tree. Once located click to select and click 
OK. Although you have opened the database no pedigrees are yet 
opened and so the main Cyrillic window is blank. In the next chapter 
we will open the pedigree and add individuals. 

Open an existing 
Cyrillic database 
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5. Drawing pedigrees 

Creating and opening pedigrees 

Before starting to draw you must have a database and a pedigree 
open. 

To create a new pedigree: 

• Select File|New pedigree 

or 

• Click the New pedigree icon 

This opens the Pedigree properties dialog. 

• Add a name for the pedigree and any notes 

• Click OK 

To open a pedigree: 

• Select the File|Open pedigree menu option 

or 

• Click the Open pedigree icon 

This opens the Select Pedigree dialog. 

• Locate and click on the pedigree you wish to open 

• Click OK 

• Make any changes to the details in the Pedigree Properties dialog 
and click OK 

 

Create a new 
pedigree 

Open a pedigree 
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A tab with the pedigree name appears at the top of the drawing area. 
You may have several pedigrees open at one time and switch between 
them by clicking on the tabs 

The Search button on the Open pedigree dialog allows for simple 
searches to be performed on the current database. This is particularly 
useful if you have large databases with many pedigrees. To search for 
pedigrees containing specific information: 

• Select File|Open pedigree or click the Open pedigree icon 

• Click Search or Alt+S 

This opens the search dialog. 

 

The select pedigree 
dialog 

Searching for 
pedigrees 

The Search pedigrees 
dialog 
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This comprises two drop down lists. The upper lists searchable fields 
of the database, the lower one is intially empty and is in effect an edit 
box. The fields on which you can search are: 

INDIVIDUAL: First name 

INDIVIDUAL: Last name 

INDIVIDUAL: Maiden name 

INDIVIDUAL: Known as 

PEDIGREE: Identification 

PEDIGREE: Name 

PEDIGREE: Author 

 

Accordingly it is possible to find pedigrees either by their contents or 
by the person who created them. 

Under the heading ‘Matches’ type the text you wish to search for. For 
example if you want to find pedigrees with the last name or surname 
Jones: 

• From the drop down list select INDIVIDUAL: Last name 

• In the edit box below TYPE Jones 

• Click OK 

If the search is successful the Open dialog appears with the pedigrees 
that include the surname Jones listed. 

When you search again, you will find text from previous searches 
saved as a drop down list. Either type new text for the search or select 
a word from the list. 
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A wildcard is a character used to represent any other characters in a 
search. For example if you have coded all of your pedigrees with a 
surname and, say an area or zip code you might want to search only 
on the name and collect all the areas. For example if your style of 
naming is say JonesLSNW1 to represent all the pedigrees with the 
surname Jones in an area coded as LSNW1 and you wanted to search 
for all pedigrees named Jones and in any area then you could type 
Jones* in the Contains field of the Search dialog. ‘*’ is the wildcard 
and reresents any string of characters. So searching for Jones would 
find all of the following pedigrees; Jones1, JonesLSNW1, 
JonesLSNW2, Jonestown and so on.  

The wildcard can also be used in the middle of a string. E.g. Pe*er 
would find Peter, Perimeter, Pe8er and so on. Wilcards are useful but 
shoud be used with caution. Sometimes you may get too many hits or 
returns on your search making it a fruitless exercise. Furthermore the 
rules on searching are slightly different for Access and Paradox 
databases. 

Searches in Microsoft Access databases are case insensitive. Thus 
searching for jones will find all of Jones, jones, JoNes and JONES. 

Two wildcards are avaiable: 

• The asterisk, *, represents any string of characters as shown above 

• The question mark, ?, represents any single character 

i.e., Pe?er will find Peter, Peler, Peper, Pe7er but not perimeter as 
would Pe*er. 

Searches in Paradox databases are case sensitive. Thus Peter would 
find only Peter and not peteR or PeTer. 

There is only one wildcard, the percent sign, %. This represents any 
string of characters as described above for * in Access databases. 

To delete a pedigree: 

• Close all pedigrees in the database 

• Choose Delete pedigree from the File menu 

Search with 
wildcards 

Searching 
Microsoft Access 

databases 

Searching 
Paradox 

databases 

Delete pedigrees 
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• Select the pedigree you wish to delete from the Select pedigree 
dialog 

• Click OK 

You will be warned that deleting a pedigree cannot be undone. 

• Click OK to confirm the deletion 

Draw a pedigree 

In this section we will draw the following three generation pedigree. 

 

• Click the New male icon 
 

• Click the New partner (female) icon. 
 

• Click the New son icon 
 

• Click the New son icon again 
 

• Click the New daughter icon 
 

A sample pedigree to 
draw 

Draw using the 
toolbar 
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• Click on the symbol for this daughter  

• Click the Add new partner (male) icon. 
 

• Click new daughter Icon 
 

• Click on the symbol for this daughter.  

• Click New younger monozygous sister. 
 

To create the same pedigree drawing using the main menu: 

• Select Add individuals|New male 

• Select Add individuals|New partner (female) 

• Select Add individuals|New son 

• Select Add individuals|New son 

• Select Add individuals|New daughter 

• Click on the daughter symbol 

• Select Add individuals|New partner (male) 

• Select Add individuals|New daughter 

• Select the daughter just added 

• Select Add individuals|New younger monozygous sister 

Clicking anywhere on an empty pedigree drawing with the right 
mouse button opens the context menu. If no individuals are selected 
or the pedigree is empty then only the Add new 
mal/female/individual sub menus are active. When an individual is 
selected then all the menu items are active. The sub menu, Add 
individuals, is identical to the main Add individuals menu. You can 
therefore draw this pedigree using the RMB menu following the 
instructions above.  

Draw using the 
main menu 

Draw using the 
context menu 
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When using the RMB menu note: 

• If no individuals are selected then only New individuals are 
available 

• You do not have to click on an individual symbol to invoke the 
RMB but the options available are in context with whatever is 
selected 

• If a marriage line is selected then you can only add offspring or 
new individuals 

• If an individual is selected you can add new relationships and 
offspring 

The Add individuals|Add family of siblings and Add 
individuals|Add family of siblings menu items allow you to add 
groups of individuals to an individual in the pedigree. 

• Select an individual 

• Choose the Add individuals|Add family of children or press F8 

The Add family of children dialog uses either of two methods to 
define the family. 

• Use the number edit boxes at the top to select the number of sons, 
daughters and children with undefined gender 

or 

• Use the set of radio buttons to define the sibship 

•  Starting with the first active set of buttons select male, female or 
unknown 

• Having selected the first then the second sibling becomes active so 
choose the genedr of the second sibling 

• Continue until you have the desired sibship 

Adding whole 
families 



Chapter 5 

44 Drawing pedigrees 

This method has the advantage that it is easier to define the whole 
sibship in terms of their relative ages and  uses the convention that the 
first sibling is the elder and that consecutive siblings are younger. You 
can achieve the same effect using the number edit boxes and the 
arrows to scroll the age one year at a time. For example to add a son, 
daughter and a younger son: 

• Click the up arrow next to the Son(s) edit box to add 1 son 

• Click the up arrow next to the daughter(s) edit box to add 1 
daughter 

• Click the up arrow next to the Son(s) edit box so that it reads to 
add 2 sons. 

 

To do the same using radio buttons 

• Click Male 

• Click the next column, Female 

• Click the next column male 

The Add family of 
children dialog  
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After drawing a pedigree you will need to save it. Either: 

• Select File|Save pedigree 

• Click the save pedigree icon 

• Press F4 

• If you have several pedigrees open then you can save all of your 
work by clicking the Save all tool or selecting File|Save all 

Whenever you close Cyrillic you will be invited to save any work you 
have done: 

• Click Yes to save the changes you have made to the pedigrees in 
the database and close the program 

• Click No to close the program without saving 

• Click Cancel to close the dialog and return to Cyrillic - without 
saving 

To delete an individual or group of individuals: 

• Select the individual or group of individuals 

• Press the delete button 

Note that deleting an individual cannot be undone inless you take a 
snapshot (Edit|New snapshot menu) before the deletion and then 
return to the snapshot later (Edit|Go to snapshot menu). 

Arranging the pedigree on the page 

The main drawing area on the Cyrillic window is marked out with 
dotted lines indicating the page area. The Cyrillic canvas is essentially 
infinite but these marks will help you arrange your pedigrees prior to 
printing. 

Save the 
pedigree 

Delete individuals 
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It is common for  some individuals to be placed outside the page lines, 
for example, as a sibship grows. To set the pedigree within the page 
border either: 

• Select File|Page border menu item 

• Click the page border icon. 

To set the pedigree in the Home position - by default at the top left 
hand corner of the drawing use any of the following methods: 

• Select View|Home 

• Click the Home icon on the toolbar 

• press Ctrl+H 

As you draw or rearrange a pedigree you may need to move 
individuals or groups of individuals to make room for new 
individuals. To move an individual: 

• Select the individual by clicking on the symbol 

• Drag the individual to the new location 

To move a group of individuals: 

• Select the group either by clicking on an empty part of the 
drawing area and dragging around the group or clicking on them 
one by one whilst holding down the Shift or the control key 

• Drag the group to the new location 

For automatic redraw of the pedigree either 

• Select View|Redraw 

• Press F5 

• Click the Redraw tool 

Reset the page 
border 

The Home button 

Redraw 
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This redraws focussing on placing individuals in the correct 
generation, i.e., it realignns the pedigree in a vertical fashion. The 
redraw is focused on a selected individual but will work even if none 
are selected. This should be used with caution and prior to redrawing 
it is wise to take a snapshot (See using snapshots) of the pedigree just 
in case the results are not what you expect! 

The snapshot is really a customized ‘Undo’ feature. At any time you 
may take a snapshot of the pedigree and save it temporarily to 
memory. The snapshot includes the pedigree and all the data (results 
of risk calculations, annotations, properties). If you then make 
changes which turn out to be unsatisfactory you can return to the 
earlier state defined by the snapshot You can take as many snapshots 
as you like but should remember that they are lost when you close the 
database. Snapshots are useful: 

• When performing risk calculations as they allow you to edit data 
and/or the pedigree, do a calculation and save results for 
comparison 

• When using the redraw feature the results may be unpredictable 
and so take a snapshot before doing the redraw 

To take a snapshot: 

• Select Edit|New snapshot 

• Type a name for the snapshot in the Create new snapshot dialog 

• Click OK 

Make any changes to the pedigree. If you decide to return to the 
previous state: 

• Select Edit|Go to snapshot 

• Choose the snapshot you wish to return to from the sub-menu 

• If you are prompted to create a new ‘autosnapshot’ to preserve 
the current status so choose Yes or No 

Using the 
Snapshot feature 
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All snapshots are lost when you close the pedigree or the database. 
Within the database you can create snapshots for different pedigrees 
and these are entirely independent. You will only be prompted to 
create an autosnapshot if you have created a state which is different 
from any of the snapshots already stored. 

Some advanced drawing features 

Cyrillic has many features that enable you to work quickly and 
efficiently even when creating complex pedigrees. Remember that the 
drawing is linked at all times to the database so that as you add 
individuals and families you are creating database entries. In this final 
section we cover some useful tips on drawing pedigrees. 

When a new individual is added that individual is highlighted so that 
a new relationship can be created directly. When a new 
partner/marriage is created then Cyrillic highlights the (horizontal) 
marriage line in readiness for the addition of offspring. As such you 
can create a sibship either by repeatedly adding offspring to a 
marriage or by adding siblings to a selected individual. 

You may have already noticed that Cyrillic is completely open in the 
pedigrees it allows you to draw. You can create 'social' pedigrees in 
addition to what might strictly acceptable as genetic pedigrees. For 
example you can draw a single parent with several children, 
relationships between males or females and add multiple sets of 
parents. This may lead to a tangle of lines that makes distinguishing 
relationships difficult. Cyrillic offers help both to the on-line user and 
in arranging relationship lines for the printed page. To demonstrate 
the following features draw the pedigree - two brothers marrying two 
sisters (shown below). 

• New male 

• New partner (female) 

• New male 

Some notes on 
drawing 

pedigrees 

Untangle the 
lines 
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• New partner (female) 

• Select the first marriage line 

• New son twice 

• Select the second marriage line 

• Click New daughter twice 

• Select the first daughter and drag to be adjacent to the first son 

• Select the second son and click to be close to the second daughter 
so that the horizontal lines overlap as in the above figure 

• Select the elder son and elder daughter then click New 
relationship to create the marriage 

• Repeat for the younger son and daughter 

Click on one of the marriage lines and see that not only is this 
relationship line highlighted but so are the lines joining all the 
offspring from that relationship. Click on an empty part of the 
pedigree to deselect the marriage line and click on one of the lines 
between siblings. This also highlights all the sibling lines and the 
relationship from which they are derived. Double clicking any of 
these lines opens the Marriage dialog. 

Another illustrative use of highlights is to show descendents. Add 
some children to one of the second generation marriages. 

Two family pedigree 
with the brothers 

marrying the sisters 

Highlights 
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• Select one of the second generation parents 

• Select View|Highlight descendants 

• Click on the blank drawing area to deselect the individual 

You should now see that the individual, spouse and all the 
descendents from that point are highlighted. 

• Reselect the parent 

• Choose Show descendants only from the View menu 

All the individuals above the selection and in other parts of the 
pedigree are removed from the display. To view only the parts of the 
pedigree above the selection: 

• Select View|Hide descendants 

To remove individual, spouse and all the descendents. To show the 
whole pedigree again: 

• Select View|Show all individuals 

Finally to remove the highlights: 

• Select View|Clear highlighting 

Three generation 
pedigree 
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Note that the Show descendents only and Hide individuals are 
functions related to the selection - not the highlight which is purely an 
illustrative feature. This is also the case when you hide parts of the 
pedigree - they are just removed from the viewbut are still in the 
database. 

The Highlights feature is helpful for the Cyrillic user – clearly 
indicating the offspring of a marriage even if there are several 
overlapping sibships - but what about the printed pedigree? Lines 
between siblings are always horizontal and so moving one set of 
siblings down separates the two sets clearly. Using the same drawing 
remove the grandchildren so that you have the simple two generation 
pedigree. 

• Select both daughters 

• Drag the symbols down a small distance 

The pedigree should now look like the figure below 

 

An alternative to moving the siblings in one generation is to change 
the marriage drawing options. This also has the advantage that the 
changes are not affected by using Redraw1. 

                                                        

1 If you realign certain parts of the pedigree in the vertical direction 
then Redraw will set them back inline with their generation – 
undoing your work!. 

Move one set of 
siblings 

The pedigree with 
one set of siblings 

offset vertically 

Marriage dialog: 
layout tab 
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Reset the pedigree so that all children are on the same horizontal. 
Open the Marriage dialog, : 

• Double click the Marriage line between the first set of parents 

• Click the Layout tab 

• Ensure that the  'Use default sibship line position' option is 
unchecked 

• Set the 'Sibship line fine adjustment' to 48% or 49% either using 
the vertical scroll bar on the preview or editing the text directly 

• Click OK. 

 

This dialog can be used to set precisely the layout of a sibship in 
relation to the parents. The result should be something like the figure 
below. 

The layout tab of the 
marriage properties 

dialog 
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The display can be further clarified by using loops to suggest cross-
over of horizontal and vertical lines. Although useful this does slow 
down redraw times and this increases significantly with large 
pedigrees. 

To display cross-over loops: 

• Select View|Options or press F6 to open the View options dialog 

• In the Drawing options tab check the Loops on check box 

• Ensure that the loops size is set to 8 or 10 

• Click OK 

 

 

The pedigree after 
altering marriage 
display properties 

Using loops 

The pedigree with 
loops on 
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6. Individual properties 

When an individual is added to a pedigree it already has a great deal 
of associated information; identification details (an accession, 
drawing, and generation numbers), the genetic status, test status and 
mortality. Many of these properties are easily edited and you can add 
more information such as addresses, comments and ethnicity. In a 
subsequent chapter we will also show how you can add customize the 
database to store any information you wish. 

There are several ways to edit the default data so that you can work in 
the way you find most convenient. You can use menus, toolbars, 
dialog boxes and Table View. 

Using the Individual dialog 

The individual dialog allows you to set or edit all of the properties 
associated with an individual. This has three panels, Individual 
properties, User-defined fields and manifestations. Here we will 
concentrate on the Individual properties tab. The User-defined fields 
tab is concerned with customized databases (Chapter 15) and the 
Manifestations tab is concerned with preparing the pedigree for 
genetic disease risk analysis (Chapter 17). 

To open the Individual dialog either: 

• Double click an individual 

• Select an individual and choose Edit properties from the Modify 
individuals main menu or RMB menu 

• Select an individual and press F12 

The first column comprises a number of edit boxes allowing input of 
personal data. To add information click in the box and add the text. A 
drop down menu allows you to set the gender as male, female or 
unknown - although this is pre-set by drawing a male, female or 
unknown on the drawing area. Changing the setting here changes the 
drawing. If you wish to simplify a drawing or do not know precise 

Open the 
individual dialog 

Identification 
details 
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family details you can add a symbol and label it as a given number of 
individuals by editing the number under Number of individuals. 

 

Under Information there are three boxes allowing you to set or 
calculate ages and dates - Age, Date of birth and Date of death. 
Knowing two of these naturally allows you to calculate the other. It is 
important to note that Age is not necessarily the current age of the 
individual and the precise definition depends on what you intend to 
do. The possible definitions are as follows 

• The current age 

• The age of death, if the person is dead 

• The age of onset of a manifestation 

To add the age: 

• Double click in the Age edit box and type a whole number 

To add the date of birth: 

The individual 
dialog 

Dates and ages 
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• Click the calendar icon 

• Use the calendar to select a date 

• Type the four digit year in the Year edit box 

You can now calculate the date of death: 

• Click the calculator icon next to Age of death 

This feature should be used with caution. Calculating the age from the 
date of birth calculates the current age, i.e., the age when you perform 
the calculation. If you are creating a pedigree retrospectively then just 
type the age in the Age edit box. Do not calculate the age of death 
unless you need this. Once calculated the program will assume the 
individual is dead. As you cannot edit the Date of death directly you 
must reset the null value. To do this: 

• Open the Date of death calendar 

• Set the date to 1st January, Year 1 (type 1 in the Year edit box) 

You can use these three items in any sequence to set and calculate the 
relevant dates or age. 

Under Information and genetic status you can set the following 
properties: 

Property Selections/Notes 

Pregnancy Unknown, Not a pregnancy, 
Spontaneous abortion, 
Therapeutic abortion, Stillborn, 
Lived one day, Neonatal death. 

No issue Normal, No issue, No children by 
choice, Infertility. NB add 
comments under Details. 

Proband Not a proband, several selections 
for the position of the porband. 

Other information 
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Property Selections/Notes 

Mortality Alive, Dead, Unknown, Suicide. 

Adoption Not adopted, Adopted in, 
Adopted out, Maybe adopted in. 

Genetic status Clear, Unaffected, Affected, 
Carrier, Maybe affected, 
Heterozygous 

Test status Normal, Untested, Examined, 
Side cross, Top cross,  Cross, 
Hearsay. 

Additional status None, Plus symbol, Minus 
symbol,  ) symbol. 

Three other edit boxes are available for you to add arbitrary text. 
These are labeled Comments, Additional information, Country of 
origin and Ethnicity. 

Finally, checking the Hide information check box hides any 
information displayed for this individual only. The information 
displayed is controlled by the Displayed fields dialog, opened from 
the View options menu (View|Options menu, Chapter 7. 
Customizing the view) 

As an exercise set the following properties for the first generation 
female in this pedigree drawn in the previous chapter: 

Last name: Jones 

First name Janet 

Gender:  Female 

Mortality: Alive 

Pregnancy status: Not a pregnancy 

Genetic status: Known to be a carrier 

Additional 
information 

Hide information 
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Age: 55 

Adoption status: Not adopted 

Test status: Examined 

 

• Double click the first generation female 

One of the useful things in Cyrillic is that several of the properties are 
already set, we have created a female, she is alive, not a pregnancy2 
and not adopted. Look at these items in the Individual dialog. Now 
set the other properties. 

• Click the arrow on the Genetic status drop down list and select 
carrier 

• Double click in the Age edit box and type the number 55 

• Click the arrow on the test status drop down list and select 
Examined 

• Click OK to accept the changes and close the dialog 

Edit properties using toolbars 

The Modify Individuals toolbar is used to change the properties of an 
individual or group of individuals. To do this: 

• Select the individual or group of individuals 

• Click the toolbar button for the property you wish to change 

                                                        

In Cyrillic a pregnancy refers to the individual as the fetus or neonate, 
and possible poiutcome of the pregnany - not to the status of being 
pregnant. 



Chapter 6 

60 Individual properties 

All of the buttons have tooltips - short hints which appear when the 
cursor is placed over the button, making it easy to identify the 
function of each tool. Toolbar buttons are toggle switches - alternately 
switching the property on and then off with consecutive clicks. If a 
property can have several values then repeatedly clicking the tool 
cycles through the various options. 

In this section we will further modify the properties of the pedigree 
produced in the Chapter 5. 

• Select the two second generation males by clicking on an empty 
part of he pedigree and dragging the mouse around them 

• Click the Maybe affected toolbar button 

The '?' symbol is added to both male symbols. To see how the toggle 
works: 

• Click on the Maybe affected symbol again 

The symbol is removed. 

We will now label the youngest female in this pedigree as a proband. 

• Select the youngest twin 

• Click the Proband tool to set the individual as a Proband 

• Click the Proband tool repeatedly to set to proband arrow in 
different locations. 

A keyboard shortcut Ctrl+R may be used to toggle the proband arrow 
though this places the arrow in the bottom left corner of the symbol 
and removes all other probands from the pedigree. 

Label several 
individuals 

Label a proband 
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Below is a complete list of Modify individuals toolbar buttons and 
their functions. 

Symbol Label Symbol Label 

 
Clear all symbols 

 
Neonatal Death 

 
Change to male 

 
Therapeutic Abortion 

 
Change to female 

 
Spontaneous 
Abortion 

 
Change to unknown 
gender  

Proband 

 
Died 

 
Untested 

 
Affected by Hearsay 

 
Examined 

 
Carrier 

 
Suicide 

 
Possibly Affected 

 
Side Cross 

 
Affected 

 
Cross Above 

 
Not Affected 

 
Lived One Day 

 
Pregnant 

 
Plus Symbol 

 
Heterozygous 

 
Minus Symbol 

 
Still Born 

 
O symbol 

The toolbar 
buttons 
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Edit properties using menus 

After selecting an individual you can change the properties using 
either the main menu or the context menu. Changes are made using 
the Modify Individuals menu and sub-menus. 

 

For example to set the affection status of an individual: 

• Select the individual 

• Select the Modify individuals|Affection|Carrier menu item from 
either the main menu or the RMB context menu 

The individual is labeled with the carrier symbol. As with toolbars the 
labels are either simple toggles or will cycle through the options if 
several are available. To remove the Carrier label: 

• Select the individual labeled as a carrier. 

• Select the Modify individuals|Affection|Carrier menu item 

The label is removed. The menus also function for setting properties 
for several individuals. To label several individuals with a cross: 

The Modify 
individuals menu 

with Affection sub-
menu selected 
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• Select several individuals, either by dragging the mouse around 
the symbols or using the Shift+click technique 

• Click the Modify Individuals|Miscellaneous|Cross menu item 

Edit properties using the Table View  

The Cyrillic Table View displays pedigree details in a grid format. The 
table is completely configurable both in layout and in the pedigree 
properties it displays. The default view of the Table is empty and is 
controlled using the Table panel of the View options dialog. The 
layout may take either of two formats - horizontal or vertical. 

 

 

The vertical view has fields listed in the first column, the horizontal in 
the first row. 

• Select the View|Options menu item 

• Click the Table options tab 

• Click the radio button labeled Vertical in the General panel 

To choose which fields or properties to display in the table: 

• Open the View options dialog (View|Options or F6) 

• Click table fields 

The vertical (upper) 
and horizontal 

(lower)Table Views 

Configure the 
Table View 
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The Display fields dialog lists all the properties you can dislay. A 
more complete description is given in Chapter 7 but for this exercise 
we will display Surname, Age and mortality. 

• In the left hand column locate and select Surname 

• Click > to add this field to the list on the right 

• Select Age and click > 

• Select Mortality and click > 

• Click OK and OK in the main View options dialog 

These fields should now be displayed in the table view 

The table view is dynamically updated when the individual 
properties are set using menus, toolbars or the Individual dialog. 
Similarly when you use the Table view the Individual dialog will 
reflect the changes and additions. 

The table view looks like a spreadsheet and is navigated in a similar 
fashion: 

• Click on a cell to select it 

• Move around using the Up/Down/Left/Right arrows 

When an individual is selected on the drawing the row (horizontal 
view) or column (vertical view) for that individual is also highlighted 
making it easy to locate in the table view. 

As can be seen in the Individual Properties dialog box there are 
several kinds of properties, free text, numerical values, and those with 
only a limited number of values. How you edit these in the Table view 
depends on the type of property. 

• To edit free text or numerical values select a cell and type the text 

• To edit properties with a limited number of values (two or more) 
press Enter repeatedly to cycle through the possible values 

Navigating the 
Table View 

Editing 
properties in the 

Table View 
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For example, edit the properties if the first generation male in the 
pedigree created in Chapter 5. 

• Click the cell labeled Surname in the first column (with the table 
in Horizontal view) 

• Type Jones and press Enter 

• Press the Right arrow key twice so that the eldest second 
generation male is selected 

• Type Jones and press Enter 

Now change the mortality status of the second son: 

• Press the right arrow key and then the down arrow key 
repeatedly so that the Mortality cell for the second son is selected 

• Press the Enter key twice to change the Mortality to Dead 

• Press the Enter key twice again to change the Mortality to 
Unknown 

To change a numerical value such as Age select the cell either by 
locating it using the arrow keys and pressing Enter and then type in 
numbers 

Some care should be exercised when editing properties with a fixed 
number of values e.g., the proband or the gender. It will be possible to 
enter text in the gender field but as you press Enter to accept the text 
the table merely cycles to the next allowed value - which may result in 
some confusion between what you have typed and what you see as 
the result. 

In practice the table can be used for rapid data input and is 
particularly useful when you have large pedigrees. Another hint for 
speed is to use the Set Individual defaults dialog and Set marriage 
defaults dialog, accessed from the Setup menu. these are identical to 
the Individual and marriage dialogs but the properties set become 
deafault for a whole database. So if you are developing a database for 
an extended family, all called Jones you can set the default surname 
and do not need to add this information later for every individual. 
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7. Customizing the view 

The Cyrillic window is completely configurable, making it easy to 
change the way Cyrillic looks and works for you. 

Increasing the workspace 

You may find that the drawing area is smaller than you would like or 
that you do not need to see the Table view constantly. There are two 
ways to easily increase your workspace - hide the table and remove 
toolbars. To remove the Table view: 

• Place the cursor over the gray line joining the main drawing area 
and the table view so that the cursor changes from an arrow to a 
vertical split arrow 

• Click and drag the cursor down to reduce the size or remove the 
table completely from view 

To bring the table back into view: 

• Place the cursor over the border at the base of the drawing area so 
that the vertical split arrow appears 

• Click and drag upwards until the Table comes into view again 

The Options|Toolbars sub-menu allows you to select the toolbars you 
wish to use. By default they are all displayed. To deselect, for 
example, the Modify individuals toolbar: 

• Choose the Options|Toolbars|Modify individuals menu item 

When a toolbar is displayed the menu item has a tick adjacent in the 
menu itself. When you deselect the tick is removed. 

The toolbars are described below. 
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Name Function 

Application General program functions, 
open/create databases and 
pedigrees, save, print etc. 

Add individuals Add new individuals, parents 
and children. 

Younger siblings Add younger siblings only 

Elder siblings Add elder siblings only 

Modify individuals Change the status or properties 
e.g., gender, genetic status, label 
as proband. 

Manifestations Configured by the user to label 
manifestations3. When a 
manifestation is created then a 
colored button is added to this 
toolbar. 

Drawing options 

Drawing options are controlled using the View options dialog. This 
has two tabbed panels, the first controlling the drawing and the 
second controlling the Table view. To open the View options dialog 

• Select the options item from the View menu or press F6 

This panel allows you to change all aspects of the drawing tools, line 
thickness and color, symbol size, the spacing of symbols on the 
drawing, colors used and fonts used for labels. 

                                                        

3 A manifestation is similar in function to family diseases in Cyrillic 
version 2. They are used for risk analysis calculations. Chapter 16 
describes the use of manifestations in detail. 
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The line width is changed using the number edit box labeled Line 
width. To change the value either: 

• Double click in the Line width edit box in the Lines panel 

• Enter a number for the new line width 

or 

• Click the up and down arrows on the right of the edit box to scroll 
through possible values 

Three buttons labeled Line, Selection and Highlight are used to 
change the colors. Each opens the Color dialog box. This is a typical 
Windows type color dialog (Chapter 11. Editing colors). 

Line changes the color of all lines including the symbols for 
individuals. 

Selection changes the color of the box drawn to indicate that an 
individual has been selected. 

The View options 
dialog, Drawing 

options tab 

Line width 

Changing colors 
used 
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Highlight is the color used to indicate descendant lines to siblings 
from a selected marriage or when View highlighted individuals is 
selected from the View menu. 

For example to change the Selection color to blue and the Highlight 
color to red: 

• Open the View options dialog by selecting the Options item from 
the View menu 

• Click the Selection button 

• Click the Blue square in the Color dialog 

• Click OK to close the Color dialog 

• Click the Highlight button 

• Click the Red square in the color dialog 

• Click OK to change the color dialog 

• Click OK to close the View options dialog 

Select an individual on your pedigree and note that the square around 
the symbol is now blue. To see the descendant line (highlight color) 
select a marriage line and note the color of the lines to all the offspring 
from this marriage. Or select an individual and choose 
View|Highlight individuals to highlight all the descendants of that 
individual. 

The Symbol panel of the Drawing options tab allows you to set the 
symbol size and fonts for symbol labels and legends. To change the 
size of the symbols: 

• Click the Symbol size button 

This opens the set symbol size dialog. To change the size: 

• Double click in the number edit box and enter a new size 

• Use the up and down arrows to scroll through possible values 

Change Symbol 
size 
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The dialog shows a live update of the symbol sizes. Some caution 
should be exercised when changing sizes of symbols as this may lead 
to overlap in the drawing and you may need to edit your pedigree 
accordingly. 

 

Both the Symbol font and Legend font buttons open the Font dialog. 
This is a typical font dialog which allows you to set or change the font 
and attributes (style, size, color etc.). The symbol font is the font use to 
label a symbol, for example for stillborn the letters SB are placed next 
to the symbol or for pregnancy the letter P appears inside the symbol. 
For example to change the symbol font: 

• Click the Symbol font button 

• In the font dialog select  Arial Black (or your own choice!), style 
Bold and size 12 

• Click OK to close the dialog 

Click OK to close the View options dialog. To see the Symbol font: 

• Select an individual 

• Click the Pregnancy toolbar button to label as a pregnancy 

The Cyrillic drawing uses an invisible grid to set the spacing between 
individuals as they are added to the pedigree. The Spacing panel 

The Set symbol size 
dialog 

Change symbol 
fonts 

Spacing 
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controls all aspects of this grid. The numbers are arbitrary distances 
but are obviously related to symbol size. The different controls are 
defined as follows: 

Snap to grid. When this is checked individual symbols will 
automatically align to the underlying grid. This can be very useful in 
ensuring even spacing between individuals as you draw and edit, i.e., 
move, individuals. This can occasionally lead to difficulties in aligning 
siblings symmetrically below parents, or if you need to move an 
individual by a very small amount as they will always be placed at the 
nearest grid lines. For complete control uncheck the Snap to grid. 

Redraw spacing sets the distance between individuals when the 
Redraw function is used. 

Partner spacing The horizontal distance between spouses. 

Sibling spacing The horizontal distance between siblings. 

Parent spacing/Child spacing The vertical distance between parents 
and offspring is divided into two regions. This is noticeable only 
when there are more than one sibling or a child is offset from the 
center of the marriage line. 

 

The setting in this dialog can be considered the default for all families. 
You can change the relative distances for individual families using the 
marriage properties dialog, Layout tab. 

There are three check boxes, defined as follows. 

Kinship coefficients. When checked will display the calculated 
kinship coefficient for a consanguineous relationship. 

The parent and child 
distances 

Consanguinity 
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Auto detect. When checked Cyrillic will automatically detect 
consanguineous relationships and display them as a double line. The 
kinship coefficient is only displayed if this is also checked  

Manual settings. When checked and the relationship has been set as 
consanguineous in the Marriage dialog then the relationship is 
displayed with double lines. 

The number edit box sets the number of steps taken with each click of 
the Zoom tool. Increasing the number reduces the number of clicks 
needed to zoom in or zoom out. 

These options allow you to configure the size, color and style of the 
proband arrow. 

Color opens the Color dialog. To change the proband color: 

• Click the Color button 

• In the Color dialog choose a color and click OK to close the dialog 

Width and length. Edit these boxes to change the width and length of 
the arrow. 

Style. Three sample arrow styles are shown. Check the style you 
prefer. 

 

When checked this causes vertical lines to display a loop when 
crossing a horizontal line. This is useful when your pedigree has 
many lines which cross each other - to distinguish between family 
relationships or sibships. In large pedigrees the use of loops may slow 
redraw time and so this is best used for small pedigrees or just for 
display purposes when needed. 

Zoom 

Proband 

The three proband 
arrow styles 

Loops 
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Table options 

The Table view is controlled using the Table options tab of the View 
options dialog. To open this tab: 

• Select Options from the View menu or press F6 

• Click the Table options tab 

 

The top half of this tab shows a preview of the table view, updated as 
you make changes to the dialog. 

Horizontal/Vertical. These radio buttons select either the horizontal 
or vertical layout for the table. In horizontal layout the properties are 
labeled in the first row, in Vertical layout the properties are displayed 
in the first column. 

In this pedigree the 
son of the second 

marriage is clearly 
distinguished from 
those of the first by 

the loop 

The View options 
dialog, Table options 

tab 

General 
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Color. Opens the Color dialog and sets the background for the table. 
To set the background color as gray: 

• With the Table options panel of the View options dialog open 
click Color 

• In the Color dialog select the gray square 

• Click OK to close the Color dialog 

• Note that the color on the preview changes to gray 

• Click OK to close the View options dialog and update the table 
view background color 

Selection. Sets the color used to highlight a row or column when that 
individual is selected. To set the Selected color as green 

• With the Table options panel of the View options dialog open 
click Color 

• In the Color dialog select the green square 

• Click OK to close the Color dialog 

The Highlight color on the preview changes to green 

• Click OK to close the View options dialog and update the table 
view Selected color 

Note that the colors chosen for the Table and the Drawing are 
independent of each other. 

Width/Height. The Width and Height number edit boxes are used to 
control the width and height of the cells making up the grid of the 
table view. To edit them either: 

• Double click in the edit box and type a new number 

• Click on the up and down arrows to scroll through the number 
range 

Cells 
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Font. Opens the Font dialog and is used to set the font for text in the 
cells. To change the font to Arial bold, size 12: 

• Click the Font button to open the Font dialog 

• Select Arial 

• Select Bold under Font style 

• Select 12 under Font size 

• Click OK to close the Font dialog 

Grid line width. Use the number edit box to change grid line widths. 
These are updated automatically in the preview. Either: 

• Double click in the edit box and type a new number 

or 

• Use the up and down arrows to the right of the edit box to scroll 
through possible values 

When you set the lines to zero width (value=0) the lines are removed 
altogether. 

Show border. Check to display the Table view with a border. 
Uncheck to remove the border. 

3D. When checked gives the property label cells a 3D look. 

Displaying properties 

One of the most common tasks when drawing a pedigree is choosing 
which properties to display. This is fully configurable using the View 
options dialog. Two buttons labeled Drawing fields and Table fields at 
the bottomof the dialog open the Displayed fields dialog. The former 
sets the display for the drawing and the latter for the Table view. 

The dialog looks identical for both but works independently. As such 
you can display a different properties on the drawing and in the table. 

Grid 
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For example you could display just identification and age information 
on the drawing and all genetic information in the Table view. 

The properties that can be displayed include those defined by the 
Individual dialog and some inherent in the pedigree drawing itself 
e.g. generation labels. These are as follows. 

 

 

Property Notes 
Accession number Drawing sequence number of 
Order (X) Single number (integer) ID 
Order (XXXX) ID in format Generation: contemporary 

e.g., 3002 is generation 3, contemporary 
2 

Gender  
Age  
Number of individuals  
Information hidden  
Suicide  
Mortality  
Pregnancy  
Adopted  
Genetic status  
Test status  

The Displayed fields 
dialog 
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Proband  

Comments  
Generation Label just the generation number. 
Contemporary label just the contemporary 
Generation contemporary label generation and contemporary e.g. 

II:2 
Number of manifestations  
Number of marriages  
X X coordinate on the drawing 
Y Y coordinate on the drawing 
No issue No children 
No issue reason e.g. infertility, by choice. 
Surname  
Other names  
First name  
Known as  
Maiden name  
Ethnicity  
Co of origin  
Address  
Additional info  
These properties are listed in the left hand panel of the dialog. If you 
have defined some of your own fields or have imported a pedigree 
from Cyrillic version 2 all of the additional data fields will be listed 
here. The right hand panel lists those properties that are to be 
displayed on the pedigree (drawing or table). 

To display all properties: 

• Click the double headed, right arrow, >> 

To display no properties whatsoever: 

• Click the double headed, left arrow, << 

This removes all the properties from the right hand panel. To add one 
property to the displayed list: 

Add properties to 
be displayed 



Chapter 7   

Customizing the view 79 

• Select the property on the left by clicking on it. Once you have 
clicked on one property you can move down the list by pressing 
the Down arrow on your keyboard 

• Click the button labeled with a single arrow, > 

A single property may be removed from the list by selecting it and 
clicking the left arrow button, <. 

You can select several properties at a time. To select a contiguous 
range: 

• Click the first property in the range 

• Locate the property at the end of the range and with the Shift key 
held down click on this, last property 

To select several properties not in a single range: 

• Click on the first property 

• With the Control key (Ctrl) pressed click on the second property 

• Select additional properties whilst pressing the Control key 

Once the selections have been made add them to the display list by 
pressing the right arrow button, >. Note that the double headed 
arrows always transfer all of the properties. The single arrows transfer 
only those selected. 

Default View options 

You can set the default View options for a database using the 
following procedure: 

• Close all pedigrees 

• Choose View|Options or press F6 

• Set options in the View options dialog 
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• Click OK 

This applies to Drawing options, Table options and Displayed fields 
for all pedigrees in the database. The settings apply only to the current 
database and must be set for each database you use. 



Chapter 8   

Marriage properties 81 

8. Marriage properties 

The marriage properties dialog 

Aspects of the marriage displayed are controlled using the Marriage 
dialog. 

• Double click a marriage line or one of the descendant lines from 
the marriage 

or 

• Select a marriage line and then press F9 

This panel displays information about the marriage partners and 
allows a number of options to be set. 

 

Partners These two panels at the top display information about the 
marriage partners i.e. their individual properties.  

Identification: Add an identification for the marriage. 

Marriage 
properties tab 

The marriage 
properties dialog - 

properties tab 
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Marriage type: Drop down list with three selections - Normal, 
Divorced and Separated. Selection of Divorced labels the line with '\\' 
to indicate a divorce. 

Force consanguineous: Labels a marriage as consanguineous even if a 
consanguinity loop is not part of the pedigree drawing. 

Informal: Check box. Draws the marriage line as a single dotted line 
to imply the informal status of the relationship. 

No issue: Drop down list with the following options: Normal, No 
issue, No children by choice, Infertility. The marriage line is drawn 
accordingly. 

Two edit boxes are available. One for comments. The box below the 
No issue drop down list is for comments on No issue and these will 
be displayed on the drawing below the No issue symbol. 

Normal/Separated 

 

Divorced 
 

Force consanguineous 

 

Informal 

 

No issue 

 

No children by choice 

 

Infirtility 

 

Marriage properties 
display 
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This panel is used to customize the relationship between the parents 
and the offspring in a family. The default setting is controlled by the 
View options dialog with the use defaults check box set to on 
(checked). Unchecking this allows you to set the relative distances 
between the descendant line and the individual line, and the position 
of the sibling lines along the descendant line. 

 

To see the effect of changing the layout, uncheck the use defaults… 
check box and drag the sliders with the mouse. The best use of this 
function is really to help clarify certain parts of your pedigree - when 
there are several sibships overlapping e.g., in multiple marriage 
situations (see Page 48). 

Marriage layout 
tab 

The marriage dialog, 
Layout panel 
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9. Annotating the pedigree. 

It is often useful to add explanatory text to your pedigree drawings. In 
Cyrillic you can add annotations easily and place them anywhere on 
the drawing. You can edit them at a later date and save them to disk. 
Text is added via the Annotation dialog either: 

• Select the Tools|Annotate menu item 

• .Click the Annotation tool. 

or 

• Press Ctrl+T 

 

The main panel of the Annotate dialog is a simple text editor. All you 
need to do is type the text for the annotation in this panel. If you 
change font attributes these are updated in the dialog so that you may 
view them before adding to the pedigree drawing. To place the 
annotation on the drawing click OK or press Alt+O. 

To set the Font attributes: 

• Click the Font button in the Annotation dialog 

The annotation 
dialog box. 

Create the 
annotation 

Set the Font 
attributes 
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or 

• Press Alt+F 

For more details on using the Font dialog see Chapter 10. Editing 
Fonts. 

An annotation may, like any other object, be moved around the 
drawing. 

• Click on the annotation 

• Drag the annotation with the mouse to the desired location 

To change the text: 

• Double click the annotation to reopen the Annotation dialog 

• Edit the text in the main panel 

• Click OK to close the annotation dialog 

All annotations may be saved as simple text files. This is useful if you 
wish to add a standard piece of text to all of your pedigrees, i.e., save 
the text and reload it into other pedigrees. After typing the text for the 
annotation: 

• Click the Save as… button or press Alt+S 

This opens a Save as… dialog. 

• Navigate to the location where you wish to save your files using 
the Save in: and Up one level tools 

• Type a name in File name 

• Click Save or press Alt+S 

It is also possible to load a simple text file from disk. 

• Click Load… 

Place the  
annotation 

Save the 
annotation as a 

text file 

Load a text file as 
an annotation 
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• From the Open dialog locate the text file and click Open 

• If necessary edit the text 

• Click OK to add the annotation to the drawing 

There is an upper limit of 32KB to the size of text file that may be 
loaded by the annotation tool, i.e., this is primarily intended for 
adding short notes to the pedigree. 
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10. Editing Fonts 

The Font dialog consists of a number of panels that allow you to 
change the font, style, size, color and attributes such as underline and 
strikethrough. In all cases a preview shows how the text will appear 
so that you can experiment with different font attributes before 
applying them to your text. 

Changing the Font attributes 

Cyrillic uses text several places; annotations, symbol labels, symbol 
legends (display properties), in the Table view and in generating 
results for risk calculations. In all cases the font of the text is fully 
configurable using the Font dialog. This is invoked using a button 
labeled Font... in dialogs where text is relevant. The two principle 
locations for changing fonts are the View options dialog and the 
Annotations dialog. The dialogs for printing results of risk 
calculations are identical to the Annotations dialog. 

 

The Font dialog. 
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Available font attributes 

The following shows which fonts attributes may be configured. 

A scroll down list of the fonts available on your system. Use the scroll 
bar on the right to locate the font. Click the font you wish to use. The 
small panel labeled Sample shows a preview of the font and all its 
attributes set in this dialog. 

Four main styles are available; Regular, Italic, Bold and Bold italic. 
Click to select the style you require. 

A scroll down list of font sizes. Select a number from the scroll down 
list or type a number in the edit box. 

The effects include Strikeout and Underline. 

Select a color from a drop down list. 

The default Western script will be used unless you have other scripts 
installed on your computer. 

Changing Annotation Font 

As an exercise apply the following attributes to some text in an 
annotation. To start either open the annotation dialog and add some 
text to the dialog box or open an existing annotation.  

Font attributes: 

Font Arial 

Type  Bold, Underline 

Size  24 point 

Color Blue 

To open the Font dialog box.  

• Click Font.. in the Annotation dialog 

Font 

Font style 

Font size 

Effects 

Color 

Script 
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• To change the font scroll down the list of fonts in the top left of 
the dialog. Locate and select Arial 

• Choose Bold from the list under Font style 

• Under Font size select 24 

• Under Effects click the Underline check box 

• From the drop down list labeled Color select Blue 

• Click OK to set the font attributes 

Note that the annotation dialog displays the text as it will appear in 
the pedigree - allowing you to try font setting before you add them to 
the pedigree itself. 





Chapter 11   

Editing colors 93 

11. Editing colors 

You can choose color schemes in several places when using Cyrillic. 
The most common places to invoke the Color dialog are the View 
options and the Manifestations dialogs. 

The color dialog 

 

The main panel comprises 48 colored squares labeled Basic colors and 
16 blank squares labeled Custom colors. 

To choose one of the basic colors  

• Click in the colored square of your choice 

• Click OK to close the dialog and set the color 

To choose a color using only the keyboard; 

The color dialog 

Choose a basic 
color 
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• Press Alt+B 

• Move the focus from square to square using the Up/Down, Left 
and Right arrow keys 

• When located select the color desired by pressing the space bar 

• Click OK to choose this color 

To create a custom color first open the Custom color panel: 

• Click Define custom colors >> or press Alt+C 

 

 

The right hand panel includes a spectrum from which you may 
choose any color: 

• Click and drag the mouse in the colored panel 

A preview of the color is shown below the main panel. Alternatively if 
you know either the HSL numbers or RGB values for the color you 
require you can set these in the number edit boxes on the right. The 

Choose a custom 
color 

The Color dialog 
with Custom colors 

panel opened. 
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thin vertical panel allows you to set the Luminescence value by 
dragging the arrow to the right up and down. 

Once you have selected or created the color: 

• Click Add to custom colors 

This adds the color to one of the sixteen blank squares on the left. The 
color is added to a square which has been selected by clicking on it. 
You can add or create up to sixteen custom colors for future use. 
These can then be selected just by clicking the square displaying the 
color. Finally set the color as before by closing the dialog. 

 

Save the custom 
color 
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12. Printing 

Opening the Print preview page 

To print your pedigree first open the Print Preview page: 

• Select the File|Print menu item 

• Click the Print Preview icon 

or 

• Press Ctrl+P 

If any individuals have been selected then only these will be printed - 
so click an empty part of the pedigree before opening the preview 
window to ensure the whole pedigree is printed. 

 

As the name suggests, the window allows you to preview the 
pedigree before you print your hard copy. You can also set all page 
options. 

The print preview 
window. 
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The print preview toolbar allows you to perform the following: 

• Go ahead and print the pedigree as it appears 

• Save the pedigree as an enhanced windows metafile (.emf format) 

• Zoom in and zoom out to view the pedigree in close up or from a 
distance 

• Create a circular pedigree to fit the data on a single page 

• Arrange the pedigree on the printed page 

• Fully configure the page using the Page setup dialog (opens the 
Page setup dialog) 

The print preview toolbar 

 

 

To print the pedigree as it appears in the Print preview page: 

• Click the print toolbar button 

The pedigree may be saved in enhanced Windows metafile format 
(*.emf) simply by clicking the Save toolbar button. This opens a Save 
as… dialog. Navigate to a suitable location, name the file and click 
Save. 

 

Large pedigrees may be printed over a number of pages. The 
following tools are used to choose how you wish to view the pedigree 
in this window. 

 
View a single page only. 

The print preview 
toolbar 

Print the pedigree 

Save the 
pedigree as a 

metafile 

View pages 
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View all the pages. 

 
If View a single page is selected move to the next or 
previous pages by clicking the right or left arrow. 

 

An alternative to printing a large pedigree over several pages is to 
redraw it in circular format so that it fits easily on one page. A 
pedigree drawn in this fashion is shown below. To create the circular 
pedigree click the Circular pedigree toolbar button. 

 

To view the pedigree in close up prior to printing, or to view the 
whole pedigree from a distance use the Zoom in and Zoom out 
functions.  

Create a circular 
pedigree 

A four generation 
pedigree in circular 

format. 

Zoom in/Zoom 
out 
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There are two ways to do this. The first is to use fixed step zoom in 
and zoom out (standard magnifying glass icons). The second is to set 
the zoom ratio manually using the drop down list. 

Three buttons allow you to automatically arrange the pedigree for the 
best fit on the page. 

 
Best fit Enlarge the pedigree so that it fits 

horizontally on the page, placed at the top of 
the page. 

 
Fit to 
center 

Enlarges the pedigree so that it fits 
horizontally and centers it on the page. 

 
Reset Resets the pedigree to the original size. 

 

The Setup options button opens the Page setup dialog which controls 
all aspects of the page and the layout of the pedigree for printing. This 
is described in the next section. 

Click the close button to  close the print preview page and return to 
the main Cyrillic window. 

The Page setup dialog 

This dialog is used to set the size and position of the pedigree on the 
page, add headers and footers, printing options and circular pedigree 

Zoom options  in 
print preview 

Fit the pedigree 
to the page 

Page set up 

Close the print 
preview page 
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attributes. The dialog is opened by clicking the Page setup button on 
the print preview toolbar. 

The first tabbed panel controls margins and the position and size of 
the pedigree. The main section shows a preview of the pedigree on the 
page and positions of margins, headers and footers. Placed around 
this are four number edit boxes for control of the margins. To the 
right, at the top and the bottom are two more number edit boxes for 
setting the position of the header and footer positions. 

 

To see the effect of changing the margins: 

• Double click the Left margin edit box and type the number 400 

Note that the margin in the preview moves as you edit the number. 
To return to default setting: 

• Click Reset margin 

To the right is a panel comprising four more number edit boxes. These 
control the precise position and size of the pedigree and are edited 
directly. To maintain the aspect ratio of the pedigree ensure that the 
Keep Aspect box is checked. 

Page setup: 
margins tab 

The Page Setup 
dialog, margins tab 
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The Printer Setup button (bottom left) opens a Printer setup dialog 
allowing you to select the printer and its properties. 

This panel comprises six edit boxes where you can add text for 
headers (left, center and right) and footers (left, center and right). 

To add text to the header or footer simply type the text in the edit box 
in one or all of the positions you require. In addition five buttons 
allow you to add specific pedigree details. 

 

 
Opens the Font dialog 

The drop down lists on the right allow you to select automatic text: 

• Page number 

• Author 

• Pedigree name 

• Pedigree ID 

• Current date 

Page setup: 
Header/Footer 

tab 

Page Setup dialog, 
Header/Footer tab 
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There are three sub-panels as follows: 

Orientation: Choose either Portrait and Landscape for the orientation 
of the paper. 

Page range: Choose between printing  

• All of the pages 

• The currently displayed page 

• A range of pages 

The panel includes a hint on notation for pages. these are 1-5 for the 
range page 1 to page five inclusive, individual pages such as 3,5, 7 or a 
mixture. e.g. 3-5, 7 will print pages 3, 4,5 and 7. 

Copies: Type the number of copies you require in the Number of 
copies edit box. To ensure that they are collated check the Collate 
check box. 

Finally you can start printing directly by pressing Print now. 

This controls the layout of the Circular pedigree and is only displayed 
if you have selected Circular pedigree in the main Print Preview 
window. You can change certain attributes of the way the pedigree is 
displayed, Break angle, inner radius and outer radius. These are 
defined in the following figure. 

Page Setup 
dialog, Print 
Options tab 

Page Setup: 
Circular pedigree 

tab 
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Also included is a Font… button for setting the font of the generation 
labels (opens the Font dialog) and a check box for setting the way 
twins are displayed. Cyrillic will display twins with straight 
descendant lines unless the 'Twins as normal siblings' box is checked, 
in which case they are displayed with curved lines in the manner of 
normal siblings. 

 

Definitions for the 
circular pedigree 
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13. Importing and exporting pedigrees 

Introduction 

We have designed Cyrillic so that you can import pedigrees from 
other applications as easily as possible. Cyrillic will automatically 
detect disease data and ask whether you wish to map this data to 
manifestations in the current database or create new manifestation 
directly. 

Importing pedigrees 

The Import function is in the main File menu. To begin the import 
process: 

• Select File|Import pedigree 

Three options are available in a sub menu - Cyrillic 2, GEDCOM and 
CSV. 

Locate the file and click the Open button. A dialog listing the file 
name, path and some pedigree details invites you to confirm the 
import. If disease data is detected a third dialog will ask whether to 
create a new manifestation or map data to current manifestations in 
the database. 

Example - importing from Cyrillic 2.x 

This example imports the breast cancer pedigree shipped with Cyrillic 
2. This file is included in the Cyrillic 3 installation. 

• Either create a new database or open a database that does not 
have any manifestations 

• From the File menu select Import pedigree|Cyrillic 2 

• Locate and select the file brca.fam 

The import menu 
and dialog 
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• Click Open 

• In the confirm dialog click OK 

In the Disease mapping dialog two drop down menus appear. the 
selections are  

• Do not map disease 

• Create new manifestation 

• In both choose to Create new manifestation 

• Click OK to close the dialog and perform the import 

The pedigree is named automatically and if you open the Define 
manifestations dialog you will see that the manifestations have been 
created complete with comments about the import. 

In this example try importing the same file into the Examples.mdb 
database. This time when the Disease mapping dialog opens the drop 
down menus also include the manifestations that have been 
previously defined. These are: 

• Breast cancer 

• Bilateral breast cancer 

• Ovarian cancer 

Select the manifestation which is the equivalent of each of the diseases 
you have defined in Cyrillic 2. 

Import GEDCOM pedigrees 

The GEDCOM format is somewhat complex, but put very briefly, 
stores information in a tagged record format.  It is an ASCII text file. 
Each line contains, a level number, a tag identifying the type of 
record, and the information to be held in the record item. The file 
always begins with a header, followed by details of individuals, 
followed by details of sibships followed by a trailer.  The program 

Import into a 
database with 

defined 
manifestations 
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outputs the entire set of information so that it will be readable by 
genealogical program. Many genealogical programs will produce 
strings of warning messages about unrecognized tags, although more 
recent programs should not do so. 

Cyrillic produces files that more or less conform to the Lineage-
Linked FORM as defined by GEDCOM version 5.5.  However, there 
are some extensions to cope with the different type of data.  These 
have tags beginning with "_".  The best way to find the expected 
format for an item is to create a family and an individual with that 
item set, and export the file in GEDCOM format.  Inspection of the 
resulting file will show what is expected by Cyrillic.  Note that some 
items may be specified using several lines. A sample GEDCOM file 
with annotations is given in Appendix C: GEDCOM format, Page 165. 
A file brca.ged is included in the Cyrillic distribution. 

To import a file in GEDCOM format: 

• Select File|Import pedigree|GEDCOM 

• Locate the file in the Import dialog 

• Click Open 

You will be invited to confirm the import and to map any disease data 
to manifestations as described above. 

Import CSV 

The CSV format is simpler then the GEDCOM format and really only 
useful for importing basic pedigree data. No disease information can 
be imported. The overall file format is that a line consists of some text 
followed by carriage return & linefeed characters. On each line there 
are a number of fields separated by commas. Each line must have the 
same number of fields. 

The first line is a list of the fields used. The first fields must always be 
'INDI' (the individual ID number). If used, the _GENSTAT field must 
be the last field.  
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Subsequent lines contain data for each field in the same order as the 
header line. If no data is available then the field should be left empty. 
Numeric fields MUST NOT be empty - use a value such as 0 or -1 to 
indicate a no data situation (or don’t include that field in the file). A 
sample file is given in Appendix D: CSV format, Page 173. 

To Import a file in CSV format: 

• Choose File|Import pedigree|CSV 

• Locate the file (e.g. sample.csv included with Cyrillic) 

• Confirm the import when prompted 

• Complete any pedigreed details in the Pedigree properties dialog 

Exporting pedigrees 

You can export pedigrees in either CSV or GEDCOM format. 

• With a pedigree open select File|Export pedigree|CSV or 
GEDCOM 

You will be invited to save any work before exporting the pedigree. 

• Enter a name for the pedigree file in the New file dialog 

• Click save 

If you experience problems with pedigree import a useful measure is 
to examine the file format you are trying to import.  

• Export a pedigree to the file format you wish to import 

• Open this file in a simple text editor 

• Open the pedigree file you wish to import in the same text editor 

• Compare the two files 

Hint on export 
and import 
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In particular take a look at the header information in the Cyrillic 
export. This will tell you much about the information you are trying 
to import and what the format should be. 
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14. Introduction to databases 

One of the major differences between this and older versions of 
Cyrillic is that all information related to a pedigree is now stored in a 
database. In this tutorial we will take a look at how Cyrillic manages 
data using a database and what the advantages of this approach are 
over other methods of file manipulation. First of all we give a short 
overview of database technology. 

What is a database? 

A database is an organized collection of information or data, usually 
stored on a computer. Although simple text files and spreadsheets 
may be used as databases there are many commercially available 
systems. These facilitate both data storage and a user interface which 
aids easy data input and retrieval. In this new version we have 
replaced this user interface with the Cyrillic application - data input 
being through the various dialogs and of course, the drawing tool 
itself, as illustrated below. 

 

How is data stored in a database? 

A database consists of a number of tables, each one storing a 
particular category of information. For example one table will list 
contact information, another the pedigree information, another 
diseases, another genetic information and so on. The figure below 
shows a table for contact information. Each column is called a field - 
listing a single piece of information for each individual, e.g. First 
name, last name, address. Each row is called a record - listing all of the 
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information for a single individual. Note that in addition each 
individual is assigned a unique identification number, labeled ID in 
this example  

ID Last name First Name Address Telephone 

1 Smith Jane 21 Tree Street 1050700 

2 Smith Jane 75 Leys Lane 1150236 

3 Thomas Janet 2 Villiers Way 225252 

4 Utley Alan Berry Lane 123456 

 

This number is used in place of the name or names in other tables and 
provides an unambiguous link between the tables in the database. For 
example in the figure below knowing the ID 2 in the contact table it is 
easy to see that it is Jane Smith of Leys lane and not Jane Smith of Tree 
Street who has been diagnosed with bilateral breast cancer. 

 

Databases such as these - comprising a number of linked tables are 
called relational databases (because information in one table is related 
to information in others). Relational databases are more efficient than 
databases containing one large table both in terms of storage space 
and in speed of data manipulation. Good database design aims to 
store each piece of information only once, saving space and 
optimizing speed. 

A single table of 
contact information 

A number of related 
tables connected by 

the ID number 
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Why use a database? 

A database provides more than a convenient way of storing files - 
although the convenience of file manipulation should not be 
dismissed.  

Database technology offers the ability to search for and retrieve 
complex data sets. For example you might wish to view all the 
pedigrees of families within a certain geographical area for a certain 
time period. A database allows you to search the individual fields in 
all the tables, extract and combine all the relevant records - records 
which may not be obviously related to each other. This you simply 
could not do with a normal file storage system because the files have 
to be opened individually. 

The Borland Database Engine (BDE) 

Originally developed by Borland this is an application which allows a 
generic application such as Cyrillic to communicate with databases in 
many formats. Although commercial databases share many common 
attributes - the use of tables, a common language for searching and 
retrieving data, they all store information in their own format. A 
document written with one word processor cannot necessarily be 
opened by another because the different vendors have different 
methods of applying text attributes. In the same way a database 
developed using one application cannot necessarily be opened by 
another application. 

How a database functions is controlled to some extent by small 
programs called drivers - similar in effect to drivers which are used to 
control printers or display devices. The BDE allows Cyrillic to use 
different database formats by making drivers for many databases 
available to the application. 

How the BDE links the application to the database 

The BDE may be thought of as an intermediary between the 
application and a database, Figure 8.4. Cyrillic knows the database 
only by a short name called an alias. It does not know the type of 
database or where it is located. The BDE can locate a Cyrillic database 
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automatically and once configured also knows the internal structure 
(the tables) of the database. 

 

BDE installation 

The Cyrillic installer ensures that the BDE is installed and configured 
correctly.  

If your computer is a shared workstation or uses a shared copy of the 
Borland Database Engine, please ask your network administrator to 
read the following section before you attempt to install Cyrillic 3. 

If you already use the BDE you may need to consult your systems or 
network administrator for advice. 

When trying to install the software on a PC where the Borland 
Database Engine already exists, it is possible that the installation will 
fail.  If the BDE files are read-only, or the current user has read-only 
access to the BDE directory (network or local) then installation will 
fail. 

Resolving this involves: 

• Logging on with write-access (eg as Administrator - also required 
if ODBC is installed) 

or 

• Making the files NOT read-only 

or 

The BDE controls 
communication 

between Cyrillic and 
the database 
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• (in the case of a network installation) remove the following two 
keys from the registry 

"HKEY_LOCAL_MACHINE\Software\Borland\BLW32" 

"HKEY_LOCAL_MACHINE\Software\Borland\Database 
Engine" 

This will allow the BDE to install locally. 

**IMPORTANT: This last option involves editing the registry. Before 
you edit the registry, make sure you understand how to restore it if a 
problem occurs. For information on how to do this, see the "Restoring 
the Registry" Help topic in Regedit.exe or the "Restoring a Registry 
Key" Help topic in Regedt32.exe. 

1. You already have the BDE on your computer and you wish to 
continue using this version 

2. You use the BDE on a network and this is controlled by your 
Systems Administrator 

If in doubt consult you systems/network administrator or contact the 
Cyrillic support team. 

Configuring the BDE 

Configuring the BDE means making some settings so that Cyrillic can 
communicate with the database. The installation should configure this 
properly and you should not need to alter the settings. The settings 
are made using the BDE Administrator. This is a utility installed 
alongside the BDE which can be opened from the Windows Control 
Panel. To open the BDE Administrator: 

• Select Settings|Control Panel from the Start menu on the 
Windows Task Bar 

• With the Control Panel open double click the icon labeled BDE 
Administrator 
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On the left are two tabbed panels, each listing a hierarchical tree of 
objects. The Databases panel lists the aliases of available databases.  

The Configuration panel lists available drivers for different databases 
and BDE configuration settings. The only setting you may need to 
check is that the correct driver is used for Microsoft Access database 
format. 

• Click the Configuration tab 

• The object tree is similar to the Windows explorer tree so click the 
+ sign to open an object 

• There are two branches - Drivers and System. open Drivers 

• The next branches are native and ODBC. Cyrillic uses a native 
driver for Microsoft Access so open Native and then select 
MSACCESS by clicking the driver name 

• The right hand window opens to view the settings. Check that the 
DLL332 setting reads IDDA3532.DLL. If it is necessary to change 
the current setting click the right hand column next to DLL32 and 
a drop down list will appear. From this select IDDA3532.DLL 

• Click the Apply icon press Ctrl+A or select Apply from the Object 
menu 

• Choose Exit from the Object menu 

• You will be asked to conform that all edits should be saved to the 
configuration file (IDAPI32.cfg4) and so click OK 

It may be necessary to restart your computer following these changes 

                                                        

4 If you use the BDE on a network you will also need to check that you 
have 'write' access in order to make changes. Once again consult 
your network administrator for advice and help. 
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The Cyrillic database 

The Cyrillic database works in the background as you create and use 
pedigrees. You do not need to know the internal structure of the 
database. What is important that it is dynamically linked to the 
pedigree drawing and the Table. You can choose to display any of the 
pedigree information and add your own data fields to customize the 
database as explained in Chapters 7 (Customizining the view) and 15 
(Customizing the database). 
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15. Customizing the database 

Introduction 

For the most part you do not need to know a great deal about 
databases to use Cyrillic. As mentioned in Chapter 14 this is a 
convenient way to store data and the Cyrillic database has been 
designed to work in the background as you draw pedigrees and 
define their properties. Within the database we have created data 
fields that we hope will cover most of the information you wish to 
store. You may, however wish to customize the information to suit 
your own or your corporate needs. For example 'Address' is stored as 
a single field. You may wish to expand this to include separate streets, 
post codes or zip codes. Alternatively you may wish to add 
information for which we do not cater - adding the name of the 
hospital or genetic counselor for example. To do this you need to add 
extra fields to the database. These are called user defined fields. 

User-defined fields. 

Open the User fields dialog, 

• Choose the Setup|Define user fields menu item. 

 

This dialog lists the currently available user defined fields and allows 
you to add fields, delete fields and define the default value. 

To add a new field: 

• Click Add or Alt+A 

Creating user 
fields 

The User fields 
dialog 
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This opens the User defined fields dialog. 

 

• Type a name for the field. This may be different from the caption 
that will appear in the Table View 

• Add text for the caption 

• Use the Format drop down list to define the type of data.  

This is a convenient way of limiting the type of data used in your 
database. The data types are: 

• Text 

• Number (integer) 

• Floating point number 

• Yes/No 

• Character (non-standard keys) 

• Add any useful comments for yourself or other users of your 
database 

The User-defined 
fields dialog 
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• Click OK to close the dialog 

You must enter a Name, Caption and the Format before you are 
allowed to create the field by clicking OK. Until these are defined the 
OK button remains inactive. To close the dialog without creating the 
field click Cancel. 

When the User-defined dialog closes you may enter a value for the 
field in the User fields dialog. This is the default value and will appear 
in the table View or on the pedigree if this field is selected in Display 
fields (View options dialog, Page) for every individual. 

To add values for user defined fields for individuals open the 
Individual dialog, User-defined fields panel: 

• Select an individual 

• Choose the Edit user fields item from the Modify individuals 
menu or RMB menu 

or 

• Press F10 

• Click in the value field next to the property you wish to edit and 
type the value 

• Press Enter to enter value 

• Edit any other fields in the same manner 

• Press OK to add the information to the database 

The values added will be restricted by the limitiations imposed in 
defining the field (see defining user fields, above). e.g. if Cyrillic is 
expecting a number you may be able to type text, but it will not be 
added to the database. 

To view the user defined values either in the Table or on the drawing: 

• Open the View option dialog (View|Options menu, or F6) 

Setting individual 
values for user 

fields 
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• Click Table fields or Drawing fields 

• Scroll down the left hand panel in the Displayed fields dialog and 
select the items you wish to display 

• Click > to add them to the display list on the right 

• Click OK to close the dialog and click OK again to close the View 
options dialog 

To edit the values in the Table the field must be selected in the 
Display fields dialog for the table view. You can then edit in the same 
manner you edit other data in the Table (page 63). 

• Select the field in the Table, press Enter and edit the field 

Note that user defined fields are always added to the end of the 
default list of fields in the Displayed fields dialog. Remember also that 
changes to the database are automatically saved, and you only need to 
save pedigrees within the database. 
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16. Genetic risk analysis using Cyrillic 

Introduction 

Cyrillic 3 includes two programs for performing genetic risk analyses. 
These programs are both in the public domain but the developers 
have kindly agreed that they be supplied with at no additional cost to 
the user. The programs are MENDEL and BRCAPRO. 

MENDEL 

MENDEL is a set of Fortran 77 routines for the genetic analysis of 
human pedigree data. Its use is well established for segregation 
analysis, linkage calculations and genetic counseling. A detailed 
description of the algorithms is provided in Lange et al, 1988. Users 
can also consult other papers by Lange and colleagues (Lange and 
Elston 1975; Lange and Boehnke, 1983; Lange and Goradia, 1987; 
Goradia et al, 1992) for the theoretical background. Cyrillic 
incorporates a version of MENDEL which performs likelihood 
calculations for conditions with age-dependent penetrance. It should 
be noted that MENDEL automatically handles both inbreeding and 
monozygous twinning. 

As standard, Cyrillic is provided with penetrance tables for 
predisposition to breast/ovarian cancer based on Claus population 
frequencies (Claus et al, 1996). It is however possible to input one’s 
own population data (penetrance, prior probabilities of genotypes), 
see EXAMPLE 2, and to use MENDEL for other disorders. We also 
provide an option to use the Gompertz function for penetrance as an 
alternative to penetrance tables. 

Users should note that the developer assumes no legal liability for use 
of his software or algorithms ( End user license agreements End User 
License Agreement, Risk analysis using Cyrillic 3: BRCAPRO and 
MENDEL). 

The following files are included in the Cyrillic distribution. These are 
installed in the main Cyrillic folder on your computer. 

Overview 

Files included for 
using MENDEL 
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The main MENDEL program is encapsulated in the runMENDEL.dll 
file. In addition we use the Claus data set in the file CLAUS.ddd. 

Cyrillic automatically confirms the validity of the pedigree data 
entered when using MENDEL, i.e., whether the data is sufficient to 
run the program. you will be informed if you make an error. However 
the following check list should help you to construct suitable 
pedigrees. 

• The abnormal gene frequency must be greater than zero and less 
than one 

• Penetrance and incidence data should be greater than or equal to 
zero and less than or equal to one 

• Each individual should have either both parents or none at all 

• The age of onset of manifestation should not be greater than the 
age of the individual 

• There must be at least two age groups but for the results to be 
meaningful there should be at least 5 

• Age groups must be consecutive 

• Individuals may have age zero (the default age used by Cyrillic) 
but they will be assumed to be in the first age group 

• There must be a proband 

• Individuals must be male or female, not unknown sex 

BRCAPRO 

Excluding skin cancer breast cancer is the most common cancer in 
women. The risk of developing breast cancer in the normal population 
of the United States and Europe is 8%-10%. A family history of breast 
cancer is present in around 10% of overall cases.  Breast cancer 
susceptibility genes BRCA1 and BRCA2 have recently been identified 
(Miki et al, 1994; Wooster et al, 1995). Both BRCA1 and BRCA2 are 
considered to be responsible for a similar proportion (40%) of 

Guidelines for 
using MENDEL 

Overview 
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inherited breast cancer (Bennett et al, 1999) but the majority (81%) of 
the breast-ovarian cancer families are due to BRCA1 whereas BRCA2 
is found in the majority (76%) of families with male and female breast 
cancer (Ford et al, 1998). Carriers of BRCA1 or BRCA2 mutations from 
families with high cancer risk have been estimated to have an 85% 
lifetime risk of developing breast cancer (Bennett et al, 1999). In 
addition, BRCA1 mutations’ carriers have a 65% lifetime risk of 
developing ovarian cancer (Easton et al, 1995). 

Family members at higher risk of breast cancer can now be tested to 
see whether they are BRCA1 or BRCA2 carriers. An individual who 
undergoes genetic counseling before testing can be told the 

probabilities that he or she is a carrier, given the family history. 
BRCAPRO is a program, developed by G. Parmigiani, D.A. Berry and 
O. Aguilar at the Institute of Statistics and Decision Sciences, Duke 
University, which calculates the probability that a particular family 
member carries a germ-line mutation of the BRCA1 and BRCA2 
genes. Although the method applies to both women and men, the 
proband is usually female. The calculations are based on Bayes’ rules 
of determination of the probability of a mutation, given family 
history. An estimate of the mutation frequencies in the normal 
population (Claus et al, 1996; Ford et al, 1998) and among Askenazi 
Jews (Struewing et al, 1997) provides the probability of the mutation 
in the proband, prior to the ascertainment of family history. The 
family history includes the proband and first- and second- degree 
relatives.  Note that no provision is made for inbreeding, monozygous 
twinning, or for other relatives.  While for many families BRCAPRO 
will give a useful estimate of risk, there are some families where 
important information will not be used in the calculation.  For each 
member of interest, it is important to ascertain whether he or she has 
been diagnosed with breast cancer and either the age at diagnosis or, 
if cancer free, the current age or the age at death. Unaffected 
members are important in the calculation, but only if their current age 
or age at death is known. The method assumes that individuals 
inherit two BRCA1/BRCA2 alleles, one from each parent, that alleles 
are either normal or mutated and that mutations are inherited 
independently through an autosomal dominant mode of inheritance. 
At each locus, an individual can have 0, 1 or 2 mutations. For detailed 
explanation of the method the user is referred to the authors’ 
publication (Parmigiani et al, 1998). 
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The main BRCAPRO program is called BRCAPRO4.exe. In addition 
we include the following data sets. 

• rates_mean_claus_mar.dat 

• rates_mean_comb_aj_mar.dat 

• rates_mean_comb_non_mar.dat 

Select the data set you wish to use from the Tools|Run BRCAPRO sub 
menu. 

You should ensure that your pedigree includes the following: 

• There should be no inbreeding 

• Monozygous twins are treated as normal siblings 

• There must be a proband 

• The age of onset of manifestation should not be greater than the 
age of the individual 

Running risk analysis - summary 

The following chapters cover risk analysis in detail. However the 
main steps involved are as follows: 

• Add manifestations to the database using the Define 
manifestations dialog (Chapter 17. Manifestations -preparing for 
risk analysis (1)) 

Manifestations belong to a database and are available to any pedigree 
within that database. 

• Add disorders to the database using the Define disorders dialog 
(Chapter 18. Disorders - preparing for risk analysis (2)) 

 The setting up of disorders is more complex than manifestations and 
can be time consuming - particularly if you are using your own 
penetrance and incidence data. The define disorders dialog allows 

Files included for 
running 

BRCAPRO 

Guidelines for 
using  BRCAPRO 

Data input 
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you to save all the settings for a disorder and load them into new 
databases. To completely define a manifestation you also need to 
assign data tables and manifestations that are associated with the 
disorder. 

• Draw pedigrees and add all relevant data 

• Assign manifestations to the affected individuals 

• Set the age of onset for the manifestation using Individual dialog, 
Manifestations tab or Ages dialog 

• Run the analysis 

The Tools menu includes Run MENDEL and Run BRCAPRO items. 
Sub menus allow you to choose Disorders you have created and in the 
case of BRCAPRO which data tables to use. 

In both cases the data output is generated as a simple text file. This is 
essentially controlled by the MENDEL and BRCAPRO applications. 
You have the option of adding the result to the pedigree as an 
annotation or saving to disk. 

 

 

Data output 
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17. Manifestations -preparing for risk 
analysis (1) 

Manifestations and disorders defined 

In Cyrillic a Manifestation is the phenotypic expression of a genotype. 
A genotype is referred to as a disorder. For example breast cancer is 
considered as the expression of a BrCa1 or BrCa2 mutation. BrCa1 and 
BrCa2 are disorders and breast or ovarian cancers resulting from these 
disorders are called manifestations. Mutations such as BrCa1 and 
BrCa2 may result in more than one incidence of breast cancer and/or 
ovarian cancer and consequently each Cyrillic disorder may be used 
with one or more manifestation. 

Working with manifestations 

Before assigning manifestations to an individual they must be created 
using the Define manifestations dialog. This involves assigning a 
name, adding any useful comments, a color and pattern for the labels, 
whether the manifestation produces one or more affections and 
whether it occurs in males, females or both. 

Once a manifestation has been defined a button appears on the 
manifestations Toolbar. This button is used to apply labels as 
affections to individuals in the pedigree drawing. 

You can also apply manifestations using the manifestations tab of the 
Individual dialog. When running the calcualations you also need to 
add the age of onset of the manifestation. This can be done either 
through the manifestations tab of the individual dialog or using the 
Ages dialog.  

Manifestations are defined using the Define Manifestation dialog, 
opened using the Set up|Define manifestations menu item. 

The dialog is divided into two main regions. The left panel lists 
manifestations that have already been defined. On the right are the 
properties of the manifestations. In a new database both panels are 

Defining 
manifestations 
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blank. They become active when you click the Add button. This 
creates a new manifestation which is then defined using the 
properties on the right; name, comments, affections and so on. The 
following pages show a step by step example of creating and defining 
a new manifestation. 

 

Initially you must open the Define Manifestations dialog box: 

• Select the Set up|Define manifestations menu item 

To create and define the manifestation: 

• Click Add or press Alt+A 

• In the Name edit box type Breast Cancer 

• Under Affection pattern select Female only or press Alt+F (if this 
is to be defined as a female only manifestation) 

• To select the color (the default color is displayed in the small box 
to the left of the button) click Color or press Alt+l 

• Select a color from the Color dialog box 

• Click OK or press Enter 

The Define 
manifestations 

dialog 

Create a new 
manifestation 
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• To select a pattern instead of solid color click Pattern or press 
Alt+P 

• Select a pattern from the Pattern dialog box 

• Click OK 

• To close the Define manifestations dialog box click OK 

A circle with the defined color and pattern now appears on the 
Manifestations Toolbar. To add additional manifestations before 
closing the dialog simply click the Add button again and define the 
manifestation as before, including a new color or pattern. Note that 
pressing Enter if you are editing the comments dialog adds a carriage 
return rather than closing the dialog. 

To remove a manifestation from the database: 

• Select the Set up|Define manifestations menu item to open the 
Define Manifestations dialog 

•  In the left hand panel click on the name of the manifestation you 
wish to remove 

• Click Delete or press Alt+D 

• Click OK or press Enter to close the dialog 

The toolbar button on the Manifestations Toolbar has now been 
removed. 

To label individuals with a manifestation you must have first defined 
one or more manifestations as shown in the previous section. To add 
the label to the drawing: 

• Select one or more individuals 

• Click the colored or patterned button in the manifestation in the 
manifestations toolbar 

These labels are toggle switches, alternate clicks adding and removing 
the label. therefore to remove a label: 

Remove a 
manifestation 

Label an 
individual with 

one or more 
manifestations 
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• Select the individual 

• Click the manifestation button with the corresponding color 

To label selected individuals with multiple manifestations simply 
click additional manifestation buttons on the Manifestations toolbar. 
As manifestations are added then the individual symbol is split into 
colored regions proportionately. 

 

The Manifestations panel of the Individual dialog allows you to both 
apply a manifestation and set the age of onset (used for risk 
calculations) for that individual. To open the manifestation panel first 
either: 

• Select an individual and then select Edit manifestation from either 
the Modify individuals or RMB menu 

• Select an individual and then Press F11 

• Double click an individual and then select the Manifestations tab 

To add a manifestation to this individual: 

• Click Add or press Alt+A 

Label individuals 
with several 

manifestation 

Thee individuals 
labeled with one, two 

and three 
manifestations 

Label individuals 
using dialogs 
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Repeatedly clicking Add cycles through the manifestations defined in 
the database until they are all listed. You can now edit the 
manifestation properties for that individual. 

• Double click the manifestation (the text such as Breast cancer) you 
wish to edit. This opens the Set manifestation properties dialog 

 

Here you can  

• Change the manifestations from the drop down list (top left) 

• Add the Age of onset, used for risk analysis 

• Add any comments 

• When complete click OK to return to the Manifestations tab 

Finally click the OK button to add the changes to the database. 
Clicking Cancel closes the dialog without accepting any of the edits to 

Upper portion of the 
Manifestations tab 

of the Individual 
dialog 

The Set 
manifestation 

properties dialog 
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the manifestation properties. You will notice that the individual is 
labeled with all the manifestation colors and patterns you have 
defined. 
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18. Disorders - preparing for risk 
analysis (2) 

Disorders defined 

In Cyrillic Disorder is the term used for a specific genotype. For 
example the BrCa1 and BrCa2 mutations are disorders. The 
phenotypic expression of these mutations, i.e., breast and ovarian 
cancers are called manifestations.  

Risk analysis programs 

Cyrillic has been designed to work with third party analysis 
programs. Two of these, BRCAPRO and MENDEL, are included as 
standard with this version. These programs are available in the public 
domain but Cyrillic provides a convenient interface for preparing data 
and as such we have included them.  

Defining a disorder is similar to defining manifestation but in 
addition to naming them and adding notes must also add penetrance 
and incidence data. For your convenience we provide samples of the 
Claus data set for breast cancer risk analysis. You may however use 
your own data by adding it to the data tables accessed from the 
Define disorders dialog.  

In this chapter we provide an overview of defining disorders in a 
Cyrillic database. In subsequent tutorials we give examples of 
performing analyses with MENDEL and with BRCAPRO. 

Open the Disorders dialog 

Disorders are created and edited using the Define Disorders dialog 
box: 

• Select the Set up|Define disorders menu item 
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This is divided into two main regions. On the left is a list of disorders 
that have already been defined. In a new database or database where 
no disorders have been defined this is blank. On the right are a series 
of edit boxes and buttons used to define the disorder. For example for 
BRCAPRO analysis you can define the Sensitivity and Specificity 
values, for MENDEL analysis you can define abnormal gene 
frequency, number of age groups, whether the disorder is X-linked 
and whether or not to use the Gompertz function for the risk 
calculation. In addition there are buttons to define the manifestations 
associated with the disorder and to open dialogs for the input of 
penetrance and incidence data. 

To define a new disorder: 

• Click Add or press Alt+A 

• Type a name for the disorder in the name edit box e.g. BraCa1 for 
the BrCa1 mutation 

• Add any comments and a description to these edit boxes 

• For BRCAPRO you can directly edit the numerical values for 
Sensitivity and Selectivity (see Using BRCAPRO) 

The define disorders 
dialog 

Create a new 
disorder 
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• For analyses using MENDEL set numerical values for Abnormal 
gene frequency,  Age intervals and the Final age 

• If the disorder is X chromosome linked then click the X-linked 
check box, If it is not X-linked then ensure that this box is 
unchecked 

• If you plan to use the Gompertz function check the Gompertz 
check box 

Note that unless the Age groups edit box is set to a positive integer 
then the Disorder and Manifestations buttons are inactive. 

• To add penetrance data for the disorder click the button labeled 
Disorder… 

This opens the Configure penetrance data dialog. You may type data 
directly into the table or import from a file. 

• To add penetrance and incidence data for the manifestation click 
the Manifestations… button 

This opens first the Select manifestations dialog which enables you to 
select the manifestations for this risk analysis. After making your 
selection and closing the dialog the Configure manifestation, 
penetrance and incidence dialog opens. As with the Configure 
penetrance data dialog you may type the data directly or import from 
file. Once you have added data you can save this for future use. 

To add further disorders simply click Add and then define the new 
disorder as above. To delete disorders: 

• Select the disorder 

• press Delete or Alt+D 

This function is very convenient if you tend to work with the same set 
of disorders. Once you have defined a disorder you can save all of the 
details to disk and then load into a new database at a later date. The 
examples provided with Cyrillic include a disorder file called 
CLAUS.ddd. This includes the data for running risk analysis for 
breast/ovarian cancer using the Claus dataset. To load a disorder: 

Add and delete 
disorders 

Loading 
disorders 
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• First create a new disorder by clicking Add 

The data is loaded into this disorder. 

• Click Load and locate the file (extension.ddd) and click Open in 
the dialog 

You can view the data by clicking Disorder… in the Penetrance panel. 
You then choose the manifestations by clicking Manifestation… Once 
you have selected manifestations the Define manifestations 
penetrance and incidence dialog opens. You can check that the data is 
correct and if necessary edit it directly. 

The flip side of this is that if you have spent time creating a disorder 
and adding your own data then you can save everything using the 
Save function in the Define disorder dialog. This saves all details in a 
file with the extension '.ddd'. 

The Gompertz function is a penetrance function used to calculate 
incidence data. You select this function by clicking the Gompertz 
check box in the Analysis settings panel. This disables the Disorder… 
button. After selecting manifestations the Confgure Gompertz dialog 
opens in place of the Configure manifestation penetrance and 
incidence dialog. This allows direct input of Gompertz data for your 
disorder. 

If you choose to use the Gompertz function when you have loaded a 
disorder or penetrance data from file be warned that this effectively 
removes some of the data, so if you change your mind and uncheck 
the Gompertz check box the penetrance data will be truncated. Do not 
worry as all you have to do is reload the original '.ddd' file. 

To accept any changes and close the Define Disorders dialog: 

• Click OK or press Enter 

Using the 
Gompertz 

function 

Close the Define 
disorders dialog 
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19. Using MENDEL - example 1 

Introduction 

Here we present an example of using MENDEL. This involves 
drawing a pedigree and  setting up manifestations and disorders. You 
may simply look at the sample pedigrees in the Example1.mdb 
database included with Cyrillic though the instructions take you 
through the whole process. You will use the sample data file 
CLAUS.ddd also included in the Cyrillic installation. 

Using MENDEL for Breast cancer analysis 

Consider someone with a family history of breast/ovarian cancer who 
wants to find out their risk of developing breast or ovarian cancer. 
Our proband is a 40 years old woman whose older sister (now 57 
years old) was first diagnosed with breast cancer at the age of 47 and 
then had a new diagnosis of primary breast cancer at the other breast 
at age 57. She has another sister who developed breast cancer when 45 
and is alive and 47 years old. The proband’s mother and grandmother 
were diagnosed with ovarian cancer, her mother when 50 years old 
and her grandmother when 62 years old.  Her mother died when 60 
years old.  The proband’s paternal aunt has a breast cancer and is 85 
years old (The whole pedigree is shown below). 

The algorithm for estimation of the risk is based on locus and 
pedigree information. In our case the locus is the breast/ovarian locus 
which is inherited through an autosomal dominant mode of 
inheritance with assumed abnormal gene frequency of 0.003  and 
penetrance based on the CASH data (Claus et al, 1996). It is also 
possible to use any population data (see Chapter 20. Using MENDEL - 
using your own data) and calculations associated with X-linked 
disorders. The pedigree information consists of a sequence of 
individuals representing the various phenotypes or manifestations, 
e.g. breast cancer, bilateral breast cancer and ovarian cancer. Bear in 
mind that the relationships between individuals should be 
constructed properly in order to use MENDEL. See page124, 
Guidelines for using Mendel.  

The pedigree 

How MENDEL 
works 
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Manifestation and disorder details belong to a database rather than a 
specific pedigree and can be accessed by any pedigree within that 
database. To follow this example you may open the Example.mdb 
database included with Cyrillic. The pedigree used for this tutorial is 
called Example 1. The following instructions, however, assume you 
are starting with a new database. To  create the database and new 
pedigree: 

• Click Connect database 

• Select Create Access or Create Paradox 

• Complete the database properties details (Chapter 4: Create a 
Cyrillic database) and make the database 

• Create a new pedigree (Chapter 5. Drawing pedigrees). 

This analysis uses three manifestations, for ovarian cancer, breast 
cancer and bilateral breast cancer. 

• Open the Define manifestations dialog by selecting Define 
manifestations from the Setup menu 

• Click Add or press Alt+A 

Pedigree for 
Example 1, Running 

MENDEL 

Step 1: Open or 
create a database 

Step 2: Create the 
manifestations 
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• Type Ovarian in the Name edit box 

• Select a color and/or pattern using these buttons 

• Select female only under Affection pattern 

• Click Add or Alt+ A again to create another manifestation 

• Type Breast cancer in Name 

• Create a new color or pattern 

• Select Both under affection pattern 

• Click Add or Alt+ A again to create another manifestation 

• Type Bilateral breast cancer in Name 

• Create a new color or pattern 

• Select Both under affection pattern 

• Click OK to accept the changes and close the dialog 

If you have the manifestations toolbar in view (View|Toolbars menu) 
three discs should appear. They will not be colored until you draw 
and select an individual. 

For this example we will load a predefined disorder which includes 
the Claus data set for breast/ovarian cancer. 

• Select Define disorders from the Setup menu 

• Click Add or press Alt+A 

• Click Load or press Alt+L 

• Locate and select the file CLAUS.ddd and Click Open 

You should notice that this adds some numbers in the panel labeled 
Analysis settings. Also note that this disorder expects three 
manifestations to  have been defined. If you have not done this then 

Step 3: define 
disorders 
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you you will be prompted to define them and the Define 
manifestations dialog opens automatically. Now give the disorder a 
meaningful name. The data set used is speific to breast cancer so: 

• Type BRCA in ther Name edit box 

To check that the data included in the ddd file has been added: 

• Click Disorder… in the Penetrance panel 

This opens the Configure penetrance dialog which shows a table of 
penetrance data. In other circumstances you can load penetrance data, 
edit it directly or save it but for now just click cancel to close the 
dialog. 

Now click Manifestations… in the same panel. This opens the Select 
manifestations dialog. This example needs three manifestations to be 
defined and all should be checked. Clicking OK passes onto the 
Configure Manifestation penetrance and incidence dialog. Again you 
could load, edit or save the data but as we are checking the presence 
of the data just click Cancel. You can now close the Define disorders 
dialog by clicking OK. 

Draw the pedigree shown above (see Chapter 5. Drawing pedigrees). 
Some hints are: 

• Draw the family group I:1, I:2, II:1, II:2 and II:3 

• Draw the second family group I:3, I:4, II:4 and II:5 

• Select the individuals II:3 and II:4 

• Click the Add marriage icon 

• Add three daughters to this marriage, their spouses and children 

This is essentially the ages of the individuals. You could do this by 
opening the Individual dialog for each individual. A quick way to 
work is to use the table view. 

• Open the View options dialog (press F6) 

Step 4: Draw the 
pedigree 

Step 5: Add the 
necessary 

pedigree data 
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• Click Table options to open the Displayed fields dialog 

• Select Age and Generation: Contemporary as the fields to display 
and close the dialog 

• Click OK to close the View options dialog 

The table view will display the Generation: Contemporary numbers 
allowing you to easily identify each individual. You could also choose 
to display the same data fields on the drawing. Click in the first cell 
for age (individual I:1) and type the number 94. Press Enter and the 
right arrow key to move to the next individual. Continue adding the 
ages of the individuals as indicated in the table below. 

Individual Age Individual Age 

I:1 96 III:3 46 

I:2 60 III:4 47 

I:3 94 III:5 40 

I:4 75 III:6 40 

II:1 79 IV:1 32 

II:2 85 IV:2 22 

II:3 62 IV:3 19 

II:4 87 IV:4 16 

II:5 85 IV:5 12 

III:1 60 IV:6 17 

III:2 57 IV:7 15 

 

To complete the pedigree properties for the calculation: 
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• Select individuals I:1, I:2, I:3, I:4, II:2 and II:3 and label them as 
being dead 

• Select the female III:6 and label her as being the proband 

Note that the ages are defined as follows: 

• If a person is dead then the age is the age of death 

• Otherwise the age is the current age 

The other important age for the MENDEL calculation is the age of 
onset of the manifestation. This is set using the Set manifestation 
properties dialog. The steps involved are: 

• Select the individual 

• From the RMB menu or the Edit individuals menu select Edit 
manifestations or press F11 

 

• Click Add or press Alt+A to add a manifestation 

• Click Add repeatedly to add further manifestations 

When all the manifestations in the database have been added then the 
Add button will no longer function. The manifestations are added in 
the same sequence as they were originally defined. If you wish to add 
a manifestation out of sequence you need to edit the manifestation 
properties when you edit the Age of onset: 

Step 6: Set 
manifestation 

properties 

The upper portion of 
the  Manifestations 

tab of the Individual  
dialog 
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• Double click the manifestation highlighted in the dialog 

This opens the Set manifestation properties dialog. 

 

• From the drop down menu select the manifestation 

• Under age of onset type the age or use the arrows to scroll to the 
correct age 

• Click OK 

Adding manifestations using the toolbar buttons creates the default 
age of onset as the current age or age of death. If these are diferent 
then you must use the dialog to set the manifestation properties. 

For this example we need to set the following manifestations and ages 
of onset. 

Individual Manifestation Age of onset 

I:2 Ovarian 62 

II:3 Ovarian 50 

II:5 Breast 85 

The set 
manifestation 

properties dialog 
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III:2 Breast 47 

III:2 Bilateral breast 57 

III:4 Breast 45 

An alternative to using the Table View, toolbars or dialogs to set ages 
is to use the Ages dialog. To open the Ages dialog select an individual 
and either: 

• Select Edit ages from the Modify individuals menu or RMB sub-
menu 

• Press Ctrl+G 

The first item of the dialog is the Generation:contemporary 
identification number for the individual. If the individual has been 
labeled with any manifestations then these are listed below. Therefore 
toi use this dialog you must first label individuals with any relevant 
manifestations. To edit the ages: 

• Type the relevant age in the edit box on the right 

It is advisable to save the pedigree before performing any analyses so 
click the Save pedigree icon or select Save pedigree from the File 
menu. If you are investigating the effect of changes in the pedigree 
and data you could also make good use of the Snapshot tool 
(Edit|New snapshot menu). This saves the current pedigree and all 
the data. You can therefore make changes having saved the pedigree 
at different stages. In each case you should also save the result as a 
text file in addition to adding the output as an annotation. Once you 
are ready to run the analysis: 

• Select Run MENDEL from the Tools menu 

• In the sub-menu select the disorder you have set up, in this case 
BRCA 

The output is created as an annotation and like other annotations you 
may add this to the pedigree for display or save it as a text file. 

Age and Age of 
onset 

Step 7: Run the 
analysis 
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Based on the above assumptions and data, MENDEL will calculate the 
risk for normal, heterozygous and homozygous individual as well as 
the probability of developing a particular phenotype (manifestation) 
after a particular age interval. The population risk is provided for 
comparison. The output for our example is given below. 

 

 

 

 

Step 8: View the 
result 

MENDEL output 
for this example 
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20. Using MENDEL - using your own 
data 

Introduction 

Although we provide sample data Cyrillic has been developed so that 
you can use any penetrance and incidence data for the risk analysis. In 
this example we use data from Eccles et al (1997). 

Adding your own data 

Cyrillic provides a convenient interface for adding your own data. In 
the disorders dialog clicking the Disorder… button under Penetrance 
opens the Configure penetrance data dialog. This is a table laid out for 
the input of penetrance data under the headings Male NN, Male ND, 
Male DD, Female NN, Female ND, Female DD5. You can also load 
data from a comma delimited text file.  

When you associate manifestations to the disorder you then add the 
penetrance and incidence data. Again this can be added directly or 
loaded from a file. In this example we will add data directly to these 
tables. You may then save this data to file for future use. 

Using MENDEL for ovarian cancer analysis 

Consider someone with a family history of ovarian cancer who wants 
to find out her risk of developing ovarian cancer. Our proband is a 50 
year old woman whose older sister developed ovarian cancer at an 
age of 55 years and died when 58 years old. She has another sister 
who is 48 years old and is in good health.  The proband’s mother and 
grandmother were diagnosed with ovarian cancer, her mother when 
65 years old and her grandmother when 70 years old. Her mother 

                                                        

5 Where N stands for normal allele, D for disease allele. 

The pedigree 
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died aged 70 (see the pedigree below). The abnormal gene frequency 
of 0.028 and penetrance data are based on a segregation analysis of 
data from two different centers in the U.K. (Eccles et al, 1997). This 
pedigree is included in the Cyrillic installation in the Example.mdb 
database, pedigree Example 2. 

 

We have already created the Ovarian cancer manifestation in the 
previous example so all we need to do is create a new pedigree in this 
database. 

• Click the Create new pedigree icon 

• Complete the pedigree properties dialog 

Draw the pedigree: 

• Add new male 

• Add new partner (female) 

• Add new daughter 

• Select the daughter 

Pedigree for 
Example 2 

Step 1: Draw the 
pedigree 
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• Add new partner (male) 

• Add three new daughters 

Now set the properties as indicated in the table below. 

Individual Mortality Age Manifestation Age of onset 

I:1 Dead 85   

I:2 Dead 70 Ovarian 70 

II:1 Alive 77   

II:2 Dead 70 Ovarian 65 

III:1 Dead 58 Ovarian 55 

III:2 Alive 50   

III:3 Alive 48   

 

Finally label III:2 as the proband. 

First, create a new disorder in the Define disorders dialog: 

• Open the Define disorders dialog (Setup|Define disorders menu) 

• Click on Add 

• Type “Ovarian cancer” in the Name window 

• Type “Data from Eccles et al” in Description 

• Set the abnormal gene frequency to 0.028 

• set Age groups to 8 

• set Final age to 90 

• Click on Disorders…  

Step 2: Add the 
properties 

Step 3: Create the 
new disorder 
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You will be presented with the Configure the penetrance data table. 
Enter the data in Table 1 (below) 

When you finish click on the OK button to close the Configure 
penetrance data dialog. 

Open the Manifestations box in the Penetrance section and select 
“Ovarian cancer” in the Select manifestations window. Click OK and 
you should be presented with the Configure manifestation penetrance 
and incidence data table.  

• Enter the data shown in Table 2 and click OK 

You have now created the penetrance and incidence data for this 
example. You can save all of the data as a disorder file (.ddd) by 
clicking Save… in the Define disorder dialog. 

Now that the pedigree and data is set up, save the pedigree and run 
the risk analysis.  

• From the Tools menu select Run MENDEL|Ovarian 

The output will again be produced as a text annotation and may be 
placed on the pedigree and/or saved as a simple text file. For this 
example the output is as shown below. 

 

Step 4: Select the 
manifestation 

Step 5: Configure 
Penetrance and 

incidence 

Step 6: Run 
MENDEL 

Step 6: View the 
result 

MENDEL output 
for Example 2 
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Table 1 Penetrance 
data from Eccles et 

al (1997) 

Table 2: Penetrance 
and incidence data 

from Eccles et al 
(1997) 
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21. Using BRCAPRO 

Introduction 

Here we illustrate the BRCAPRO approach with two scenarios. The 
first corresponds to the estimation of the probabilities of carrying 
BRCA1 and BRCA2 genes in a proband affected by breast cancer. The 
second scenario corresponds to the estimation of the probability of 
developing the cancer in an unaffected proband, given a history of 
BRCA1 or BRCA2 mutations in the family. 

Scenario 1 

Our proband was first diagnosed with breast cancer at the age of 47 
and then had a new diagnosis of primary breast cancer at the other 
breast at age 57.  She is alive and 57 years old. She has a sister who 
developed breast cancer when 45 and is alive and 47 years old. Their 
younger sister is unaffected.  The proband’s mother and grandmother 
were diagnosed with ovarian cancer, her mother when 50 years old 
and her grandmother when 62 years old. Her mother died when 60 
years old. The proband’s paternal aunt has breast cancer and is 85 
years old. 

 

The pedigree 

Pedigree for this 
example 
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The presence of bilateral breast cancer in our proband as well as the 
presence of breast/ovarian cancers in first- and second-relatives 
strongly suggest the BRCA1 or BRCA2 mutation. We estimate that the 
sensitivity for BRCA1 and BRCA2 genetic test is 0.9 and that 
specificity is 0.1.  Select BRCAPRO in the Tools menu and choose an 
appropriate data set (Claus, Ford or Stuewing).  The output given 
below shows the individual and joint probabilities of carrying BRCA1 
and BRCA2 mutations based on the Ford data set (Ford et al, 1998). 

You will notice that this is the same pedigree as used in Chapter 19, 
the difference being that in this analysis we are investigating the elder 
sister in generation III as the proband. We have also defined the 
manifestations and so referring to the previous chapters you should 
be able to set up the pedigree and add the manifestations to the 
relevant individuals. Make sure that III:2 is labeled as the proband. 

Open the Define Disorders dialog: 

• Select Define disorders from the Setup menu 

• Select the disorder BRCA created in Chapter 18 

• Add the following sensitivity and susceptibility parameters: 

BrCa1 Sensitivity 0.9 

 Specificity 0.1 

BrCa2 Sensitivity 0.9 

 Specificity 0.1 

 

• Edit the Age intervals box to read 5 years 

• Click OK 

To run the analysis: 

• Select Run BRCAPRO from the Tools menu 

Step 1: Draw the 
pedigree 

Step 2: Define the 
disorder 

Run BRCAPRO 
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• Select BRCA from the sub menu 

You will be prompted to select a data set from the next sub-menu 

• Choose Ford (rates_mean_ford_non_mar.dat) 

As with the MENDEL analysis the result appear as an annotation. You 
may save this to disk and/or add it to the pedigree drawing. The 
output for this example is show below. 

BRCAPRO calculates the probability of the proband being a BRCA1 
or BRCA2 carrier. BRCAPRO provides also the joint probabilities of 
carrying mutations in both genes (carrying two mutations is rare, but 
in high-risk families it cannot be ruled out without bias to the 
calculations).  The proband can carry none, one or two mutations at 
each of the two genes. BRCAPRO calculates the probability that the 
proband carries x mutations of BRCA1 and y mutations of BRCA2 (x 
and y can be 0, 1 and 2). For example, the probability that the proband 
has no mutation of either gene is on the x = 0, y = 0 cell of the table 
(0.045919).  The table also includes the marginal probability which 
provides the probability for carrying the gene mutation irrespective of 
the other gene. For example, the marginal probability of carrying no 
BRCA1 mutation is found in the bottom row of the 0 column 
(0.200873). 

 

Scenario 2 

If the proband is unaffected by the cancer but there is a clear family 
history, one can use BRCAPRO to calculate the probability of the 
proband developing breast or ovarian cancer in the future. To 

View the result 

Interpreting the 
result 

Output for Scenario 
1 
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illustrate this feature, consider again the above pedigree and imagine 
that the unaffected 40 year old sister of the two affected women wants 
to know her risk of developing cancer.   

• Use the proband tool to remove the proband from the elder sister 
and a proband label to the younger sister. 

• Open the Define disorders dialog. 

• Set the age interval (5 years) in the Age group box. 

• Set the Final age to 85 

• Click OK to close the disorder dialog. 

• Select Tools|Run BRCAPRO|Ford 

The output for BRCAPRO is as follows is shown below. 

The probability that the proband will develop breast cancer within the 
next 15 years, that is by age 55, is 0.200563 (see below). 

 

 

Change the 
proband 

Edit the disorder 

Run BRCAPRO 
again 

View the result 

BrCaPro Output for 
Scenario 2 
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Appendix B: keyboard shortcuts 

Navigation 

When in the drawing mode use up/down/left and right arrow keys 
to navigate the pedigree. Also: 

Page up Move to first individual (top left) 

Page down Move to last individual (bottom right) 

Home  Move to first individual (left) in the current 
generation 

Function keys (F…) 

F1 Open main Help page 

F4 Save current pedigree 

F5 Redraw 

F6 Open View options dialog 

F7 Open family of siblings dialog 

F8 Open family of Children dialog 

F9  Open marriage dialog (a relationship line must be selected) 

With an individual selected: 

F10 Open Individual dialog, User defined fields tab 

F11 Open Individual dialog, Manifestations tab 

F12 Open Individual dialog, Individual properties dialog 

Without any individual selected press Control, key plus the 
following (Ctrl+) 

P Print pedigree via Print preview window  
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A Select all individuals 

H Sets the pedigree in the Home position 

T Open Annotate dialog to add annotation 

J Reset the Zoom ratio to 1:1 

K Redo page border (set the pedigree inside the border) 

I Zoom in 

U Zoom out 

With an individual or individuals selected press Control key plus 
(Ctrl+) 

C Copy to clipboard 

G Open ages dialog 

Z Undo move (only undo a move, not an addition of 
individuals) 

R Label as proband (removes all other proband labels) 
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Appendix C: GEDCOM format 

The annotations at the end of each line follow '>>'. Note that you will 
be able to copy and paste this file into a text editor and save in simple 
text format with the file extension .ged and then import into Cyrillic 3. 
If you do so make sure you remove all annotations and tab stops. 

0 HEAD >>start of the header records, always the first line 

1 SOUR Cyrillic_Pedigree_Editor >>source of the file 

2 VERS 3.0   >>version of source program 

2 NAME Cyrillic     

2 CORP Cherwell Scientific Publishing Ltd >>Details of the 
program publishers 

3 ADDR The Magdalen Centre 

4 CONT Oxford Science Park 

4 CONT Oxford OX4 4GA 

3 PHON +44 (0)1865 784 800 

3 PHON FAX +44 (0)1865 784 801 

3 PHON Email cyrillic@cherwell.com 

1 DEST Cyrillic   >>destination program 

1 DATE 07/07/99   >>date of creation of file 

1 GEDC     >>GEDCOM version used 

2 VERS 5.5 

2 FORM Lineage-Linked 

1 _FHDR  >>start of the data with the family details 

2 _FAMNUM PedID SW - 999 >>the family number - note the 
change in level 

2 _FAMNAME Smythe Wilkinson   

2 _COMMENT sample pedigree 

2 _DRAWNBY Phil Hobgen 

2 _POSITIONS T 

2 _DISEASE Breast >>list of diseases (manifestations) starts 

3 _COLOUR 16776960    

3 _PATTERN 0     

2 _DISEASE Breast 2    >>second disease 

3 _COLOUR 16711680 
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3 _PATTERN 0 

2 _DISEASE Ovary    >>third disease 

3 _COLOUR 255 

3 _PATTERN 0 

0 @I1@ INDI   >>start of the individual data -  

1 SEX M      >>gender M/F/U 

1 _PX 250     >>x co-ordinate 

1 _PY 25     >>y co-ordinate 

1 _ID SSW - 001    >>individual ID 

1 _NIND 1     >>number of 
individuals 

1 _AGE 76 >>current age or age of death, if dead, and/or 

>>age of affections 

1 ADDR 23 Farquar Lane   >>start of address record 

2 CONT Lower Farquarquarston 

2 CONT East Sussex 

2 CONT TN35 9WW 

1 _INFO Addtional information on Sebastion >>start of 

>> additional info 

2 CONT multi line format 

1 _COMMENT Comments on Sebastion  >>start of comments 

2 CONT multi line format 

2 CONT Affected - SideCross - Plus symbol 

1 _ETHNIC 0 Caucasian  >>first line ethnicity entry 

1 NATI 0 England  >>first line nationality entry 

1 NAME Sebastion/Smythe Wilkinson/ >>Firstname/Lastname/ 

1 BIRT     >>start of birth record 

2 DATE 31 OCT 1922 

1 _GENSTAT O#@@@@  >>genetic status see below 

1 _AFF F 1   >>affection of diseases 1 T/F 

1 _AFF F 2 

1 _AFF F 3 

0 @I2@ INDI   >>start of second individual 

1 SEX F 

1 _PX 305 

1 _PY 25 
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1 _ID SSW - 002 

1 _MAIDEN Harrison Farquarquarson 

1 _NIND 1 

1 _AGE 55&73  >>"age of _AFF 1"&"current age" 

1 _ETHNIC 0 Caucasian 

1 NATI 0 England 

1 NAME Susan/Smyth Wilkinson/ 

1 BIRT 

2 DATE 20 FEB 1926 

1 _GENSTAT @@@@@@ 

1 _AFF T 1 

1 _AFF F 2 

1 _AFF F 3 

0 @I3@ INDI 

1 SEX M 

1 _PX 325 

1 _PY -95 

1 _ID SSW - 003 

1 _NIND 1 

1 _AGE 37 

1 _ETHNIC 0 Caucasian 

1 NATI 0 England 

1 NAME Simon Cedric/Smyth Wilkinson/ 

1 BIRT 

2 DATE 28 FEB 1962 

1 _GENSTAT @@@@@@ 

1 _AFF F 1 

1 _AFF F 2 

1 _AFF F 3 

0 @I4@ INDI 

1 SEX F 

1 _PX 385 

1 _PY -95 

1 _ID SSW - 004 

1 _MAIDEN Blythe Tompkinsonson 
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1 _NIND 1 

1 _AGE 35 

1 _ETHNIC 0 Caucasian 

1 NATI 0 England 

1 NAME Sally/Smyth Wilkinson/ 

1 BIRT 

2 DATE 12 JUN 1964 

1 _GENSTAT @@@@@@ 

1 _AFF F 1 

1 _AFF F 2 

1 _AFF F 3 

0 @I5@ INDI 

1 SEX M 

1 _PX 295 

1 _PY -220 

1 _ID SSW - 005 

1 _NIND 1 

1 _AGE 2 

1 _ETHNIC 0 Caucasian 

1 NATI 0 England 

1 NAME Sparky/Smyth Wilkinson/ 

1 BIRT 

2 DATE 1 APR 1997 

1 _GENSTAT @@@@@@ 

1 _AFF F 1 

1 _AFF F 2 

1 _AFF F 3 

0 @I8@ INDI 

1 SEX F 

1 _PX 415 

1 _PY -220 

1 _NIND 1 

1 _AGE 0 

1 BIRT 

2 DATE 30 APR 1999 
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1 _GENSTAT @C@@@@ 

1 _AFF F 1 

1 _AFF F 2 

1 _AFF F 3 

0 @I9@ INDI 

1 SEX F 

1 _PX 220 

1 _PY -95 

1 _NIND 1 

1 _AGE 25&31&32&32 

1 DEAT      >>dead 

2 DATE ?     >>date unknown 

1 _GENSTAT @@@@@@ 

1 _AFF T 1 

1 _AFF T 2 

1 _AFF T 3 

0 @I19@ INDI 

1 SEX M 

1 _PX 355 

1 _PY 25 

1 _NIND 1 

1 _AGE 0 

1 _GENSTAT @@@@@@ 

1 _AFF F 1 

1 _AFF F 2 

1 _AFF F 3 

0 @I20@ INDI 

1 SEX F 

1 _PX 415 

1 _PY 25 

1 _NIND 1 

1 _AGE 0 

1 _GENSTAT @@@@@@ 

1 _AFF F 1 

1 _AFF F 2 
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1 _AFF F 3 

0 @F1@ FAM    >>first family record 

1 HUSB @I1@     >>husband ID 

1 WIFE @I2@     >>wife ID 

1 CHIL @I3@     >>first child ID 

1 CHIL @I9@     >>second child ID 

0 @F2@ FAM     >>second family 

>>record 

1 HUSB @I3@ 

1 WIFE @I4@ 

1 CHIL @I5@ 

1 CHIL @I8@ 

0 @F3@ FAM     >>third family 
record 

1 HUSB @I19@ 

1 WIFE @I20@ 

1 CHIL @I4@ 

0 TRLR     >>always the last line 

NOTE: _GENSTAT field format 

There are 6 placeholders (@ symbol) for the genetic status data - if no 
relevant data is available for a position then the @ symbol is left at 
that position.  

Position 1 if the individual is 'affected' an 'O' is placed here, if 
'maybe affected' a 'P' is placed here 

Remaining positions used in sequence - position is not important 

'M' No issue 

'B'  Adopted in to family 

'C' Proband 

'I' Pregnancy 

'G' Spontaneous abortion 

'H' Theraputic abortion 

'K' Still birth 

'L' Lived one day 

'J' Neonatal death 
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'E' Untested 

'Q' Top cross 

'¬' Hearsay 

'F' Cross 

'#' Plus symbol 

'-' Minus symbol 

'%' O symbol 
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Appendix D: CSV format 

CSV format for the simple pedigree: 

 

INDI,SEX,_PX,_PY,_ID,_KNOWNAS,_OTHERSUR,_MAIDEN,_NIND,_AGE,_SUIC
IDE,_ETHNIC0,_ETHNIC1,_ETHNIC2,_ETHNIC3,_ETHNIC4,NATI0,NATI1,NAT
I2,NATI3,NATI4,NAME,BIRT,DEAT,ADDR0,ADDR1,ADDR2,ADDR3,ADDR4,ADDR
5,ADDR6,_INFO0,_INFO1,_INFO2,_INFO3,_INFO4,_INFO5,_INFO6,_COMMEN
T0,_COMMENT1,_COMMENT2,_COMMENT3,_COMMENT4,_COMMENT5,_COMMENT6,_
MUM,_DAD,_SPOUSE,_GENSTAT 

2,M,465,-
190,,,,,1,62,F,,,,,,,,,,,George/Jones/,,,,,,,,,,,,,,,,,,,,,,,,,,
3,@@@@@@, 

3,F,525,-
190,,,,Smyth,1,60,F,,,,,,,,,,,Geraldine/Jones/,,,,,,,,,,,,,,,,,,
,,,,,,,,2,@@@@@@, 

4,F,495,-
315,,,,Jones,1,35,F,,,,,,,,,,,Gillian/James/,,,,,,,,,,,,,,,,,,,,
,,,,3,2,5,@@@@@@, 



Appendix D 

174 CSV format 

5,M,435,-
315,,,,,1,37,F,,,,,,,,,,,Graham/James/,,,,,,,,,,,,,,,,,,,,,,,,,,
4,@@@@@@, 

6,F,345,-
440,,,,,1,12,F,,,,,,,,,,,Greta/James/,,,,,,,,,,,,,,,,,,,,,,,,4,5
,,@@@@@@, 

7,F,465,-
440,,,,,1,10,F,,,,,,,,,,,Gail/James/,,,,,,,,,,,,,,,,,,,,,,,,4,5,
,@@@@@@, 

8,F,585,-
440,,,,,1,8,F,,,,,,,,,,,Gaynor/James/,,,,,,,,,,,,,,,,,,,,,,,,4,5
,,@@@@@@, 
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Index 

Adding whole families, 43 
Annotations, 85 

edit, 86 
load from file, 86 
save as text file, 86 

BDE 
about, 113 
Configuring, 115 
installation, 114 

BRCAPRO 
files included, 126 
overview, 124 
using, 155 

Cells 
font, 76 
width and height, 75 

Changing colors 
in View Options, 69 

Circular pedigree, 99 
Color 

of  Table view, 75 
Color dialog 

custom colors, 94 
Consanguinity 

in View options, 72 
Contact 

Cherwell Scientific Ltd, 6 
Conventions and notation, 10 
Customizing Cyrillic, 58, 67, 117 

, 67 
Customizing the database, 119 
 

, 119 
, 117 
, 78, 119 

Databases 
about, 111 

Date 
of birth, 56 
of death, 56 
of onset, 56 

Delete 

individuals, 45 
pedigree, 40 

Demo license, 4 
Dialogs 

Add family of children, 44 
Annotations, 85 
Color, 93 
Define disorders, 136 
Define manifestations, 130 
Displayed fields, 77 
Drawing options tab, 69 
Font, 89 
Individual, 56 
Individual defaults, 65 
Individual dialog, 

Manifestations tab, 133 
marriage defaults, 65 
Marriage, Layout tab, 52 
Page setup, Circular pedigrees, 

103 
page setup, general, 100 
Page setup, Header/Footer, 102 
Page setup, margins, 101 
Search, 38 
Select pedigree, 38 
Set manifestation properties, 

133 
Symbol size, 71 
User fields, 119 
User-defined fields, 120 
using, 13 
View options, Table options 

tab, 74 
Disorders, 126, 135 

definition, 135 
deleting, 137 
new, 136 

Draw 
arranging the pedigree, 45 
using main menu, 42 
using the context menu, 42 
using toolbars, 41 
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Drawing 
advanced features, 48 
overlapping sibships, 48 

Edit properties 
using menus, 62 
, 63 
using toolbars, 59 

Export 
pedigree, 108 
pedigrees, 105 

Gompertz function 
using, 138 

Grid line width, 76 
guided tour, 17 
Headers and footers, 102 
Highlight 

color, 70 
Highlights, 49 
Home button, 46 
Horizontal 

Table view, 74 
Import, 105 

CSV, 107 
, 106 
Cyrillic 2.x files, 105 
GEDCOM, 106 
map disease to manifestation, 

106 
pedigrees, 105 
troubleshooting, 108 

Increasing the workspace, 67 
Individual 

delete, 45 
Individual dialog, 55 
Individual properties, 55 
Installation 

failure, 3 
Installing Cyrillic, 2 

on a new machine, 6 
License transfer, 6 
Licensing Cyrillic, 4 
Line width 

edit, 69 
Loops, 53, 73 
Manifestations, 126, 129 

defining, 129 

definition, 129 
new, 130 

Marriage 
layout tab, 52 

MENDEL 
files included, 123 
guidelines, 124 
overview, 123 
using your own data, 139, 149 

, 147 
Pedigree 

delete, 40 
Print options, 103 
Printing, 97 

Print preview toolbar, 98 
Print Preview window, 97 

Proband 
add, 60 
arrow style, 73 
in View options, 73 

Properties 
display, 76 

Redraw, 46 
References, 159 
Registering Cyrillic, 4 
Reset 

page border, 46 
Risk analysis 

data output, 127 
overview, 123 
summary for running, 126 

Save 
pedigree, 45 

Search database 
wildcards, 40 

Searching 
Access databases, 40 
Paradox databases, 40 

Searching for pedigrees, 38 
Selection 

color in Table view, 75 
Show descendents only, 50 
Snap to grid, 72 
Snapshot, 47 
Starting Cyrillic, 27 
Symbol fonts 
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edit, 71 
Symbol size 

edit, 70 
Symbol spacing, 71 
System requirements, 2 
Table View 

configure, 63 
Table options, 74 

, 64 
Table View 

editing properties, 64 

Table View 
navigating, 64 

, 119 
User fields 

setting values, 121 
Vertical 

Table view, 74 
View options, 67 

default settings, 79 
Drawing options, 68 
Table options, 74 

 


